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Chapter 1 Introduction

1.1

1.2

The Varian MR is the system of choice for laboratories requiring a compact and easy-to-use
instrument that delivers fast and reliable results day in and day out. The Varian MR system
provides unmatched productivity for diverse chemical applications by combining easy-to-use
software with outstanding performance. Push-button experiments, along with straightforward
processing and data export capabilities, make the MR the best choice for compound detection,
guantification, and structure confirmation.

Advanced automation accessories enable users to take full advantage of the MR capabilities.
These technologies seamlessly integrate with sample-centric data management in the VnmrJ
software.

About This Guide

This VnmrJ Automation User Guide describes how to gather MR data using VnmrJ 3 and 400
MHz system automation features.

Chapters in this user guide include:
e Chapter 1, Introduction
e Chapter 2, VnmrJ Liquids Interface Description
e Chapter 3, Prepare and Load Samples
e Chapter 4, Studies
e Chapter 5, Reprocessing Data
e Chapter 6, Interpreting Data
e Chapter 7, Printing, Plotting, and Data Output
e Chapter 8, VnmrJ 3 Preferences

Warnings and Caution Symbols
This user guide helps establish operating conditions that permits safe and efficient use of the

equipment. Special considerations and precautions are shown in the form of NOTES,
CAUTIONS, and WARNINGS as described below. Operate the equipment in accordance with

this user guide and any additional information provided by Varian. Contact Varian, Inc. if there are

any questions regarding the safe and proper use of your equipment.

The following warning and caution notices illustrate the styles used in this user guide for safety
precaution notices and explain when each type is used.

NOTE: Notes give additional and important information.

Warning Symbol Warning Description
Alerts you to situations when failure to observe instructions
CAUTION could result in serious damage to equipment or loss of
data.




Alerts you to potentially hazardous situations that could
result in serious injury or death to humans or animals, or
significant property damage.

WARNING:
SHOCK HAZARD

Hazardous voltages are present inside instrument.
Disconnect from main power before removing screw-
attached panels. No user serviceable parts inside system.

WARNING:
BURN HAZARD

Very hot or cryogenically cold surfaces may be exposed.
Use proper skin protection.

WARNING:
A@" EYE HAZARD

Eye damage could occur either from flying particles,
chemicals, or UV radiation. Use proper eye and face
protection.

WARNING:
FIRE HAZARD

The potential for fire may be present. Follow user guide for
safe operation.

WARNING:

EXPLOSION HAZARD

The potential for explosion may exist because of type of
gas or liquid used.

a WARNING:
MOVING PARTS

Keep hands and fingers away.

1.3 General Safety Precautions

1.4

Follow these safety procedures to ensure safe equipment operation:

e Perform periodic leak checks on all supply lines and pneumatic plumbing.

e Do not allow gas lines to become kinked or punctured.

e Put lines away from foot traffic and extreme heat or cold.

Warning Notices

Observe the following precautions during installation, operation, maintenance, and repair of the
instrument. Failure to comply with these warnings or with specific warnings elsewhere in Varian
documentation violates safety standards of design, manufacture, and intended use of the
instrument. Varian assumes no liability for customer failure to comply with these precautions.

AWARNING

Persons with implanted or attached medical devices such as
pacemakers and prosthetic parts must remain outside the 5-gauss
perimeter from the centerline of the magnet.

The superconducting magnet system generates strong magnetic fields that can affect operation
of some cardiac pacemakers or harm implanted or attached devices such as prosthetic parts and
metal blood vessel clips and clamps



Pacemaker wearers should consult the documentation provided by the pacemaker manufacturer
or contact the pacemaker manufacturer to determine the effect on a specific pacemaker.
Pacemaker wearers should also always notify their physician and discuss the health risks of
being in proximity to magnetic fields. Wearers of metal prosthetics and implants should contact
their physician to determine if a danger exists.

Refer to the documentation supplied with the magnet for the size of a typical 5-gauss stray field.
Check this gauss level after the magnet is installed.

Keep metal objects outside the 10-gauss perimeter from the centerline
WARNING of the magnet.

The strong magnetic field surrounding the magnet attracts objects containing steel, iron, or other
ferromagnetic materials, which includes most ordinary tools, electronic equipment, compressed
gas cylinders, steel chairs, and steel carts. Unless restrained, such objects can suddenly fly
towards the magnet, causing possible personal injury and extensive damage to the probe, dewar,
and superconducting solenoid. The greater the mass of the object, the more the magnet attracts
the object.

Use only non ferromagnetic materials, for example, plastics, aluminum, wood, nonmagnetic
stainless steel, and so on, in the area around the magnet. If an object is stuck to the magnet
surface and cannot easily be removed by hand, contact Varian service for assistance.

Refer to the documentation supplied with the magnet for the size of a typical 10-gauss stray field.
Check the gauss level after the magnet is installed.

Only qualified maintenance personnel removes equipment covers or
WARNING makes internal adjustments.

Dangerous high voltages that can kill or injure exist inside the instrument. Before working inside a
cabinet, turn off the main system power switch located on the back of the console.

AWARNING Do not substitute parts or modify the instrument.

Any unauthorized modification could injure personnel or damage equipment and potentially
terminate the warranty agreements or service contract. Written authorization approved by a
Varian, Inc. product manager is required to implement any changes to the hardware of a Varian
MR spectrometer. Maintain safety features by referring system service to a Varian service office.

AWARNING Do not operate in the presence of flammable gases or fumes.

Operation, with flammable gases or fumes present, creates the risk of injury or death from toxic
fumes, explosion, or fire.

AWARMNG Leave area immediately in the event of a magnet quench.

If the dewar should quench (sudden appearance of gasses from the top of the dewar), leave the
area immediately. Sudden release of helium or nitrogen gasses can rapidly displace oxygen in an
enclosed space creating a possibility of asphyxiation. Do not return until the oxygen level returns
to normal.



1.5

AWARNING Avoid helium or nitrogen contact with any part of the body.

Cold gasses or liquids (helium and nitrogen) contacting the body can cause an injury similar to a
burn. Never put your head over the helium and nitrogen exit tubes on top of the magnet. If helium
or nitrogen contacts the body, get immediate medical attention, especially if the skin is blistered
or the eyes are affected.

AWARNING Do not look down the upper barrel.

Unless the probe is removed from the magnet, never look down the upper barrel. You could be
injured by the sample tube as it ejects pneumatically from the probe.

Do not exceed the hoiling or freezing point of a sample during variable
WARNING temperature experiments.

A sample tube subjected to a change in temperature can build up excessive pressure, which can
break the sample tube glass and cause injury by flying glass and toxic materials. To avoid this
hazard, establish the freezing and boiling point of a sample before doing a variable temperature
experiment.

AWARMNG Support the magnet and prevent it from tipping over.

The magnet dewar has a high center of gravity and could tip over in an earthquake or after being
struck by a large object, injuring personnel and causing sudden, dangerous release of nitrogen
and helium gasses from the dewar; the magnet must be supported by at least one of two
methods: with ropes suspended from the ceiling or with the anti-vibration legs bolted to the floor.
Refer to the Pre-installation Instructions for details.

AWARNING Do not remove the relief valves on the vent tubes.

The relief valves prevent air from entering the nitrogen and helium vent tubes. Air that enters the
magnet contains moisture that can freeze, causing blockage of the vent tubes and possibly
extensive damage to the magnet. It could also cause a sudden dangerous release of nitrogen
and helium gasses from the dewar. Always be sure to secure the relief valves on the vent tubes
except when transferring nitrogen or helium.

Caution Notices

Observe the following precautions during installation, operation, maintenance, and repair of the
instrument. Failure to comply with these cautions or with specific cautions elsewhere in Varian
documentation violates safety standards of design, manufacture, and intended use of the
instrument. Varian assumes no liability for customer failure to comply with these precautions.

Keep magnetic media, ATM and credit cards and watches, outside the
CAUTION 5-gauss perimeter from the centerline of the magnet.




1.6

1.7

The strong magnetic field surrounding a superconducting magnet can erase magnetic media
such as floppy disks and tapes. The field can also damage the strip of magnetic media found on
credit cards, automatic teller machine (ATM) cards, and similar plastic cards. Many wrist and
pocket watches are also susceptible to damage from intense magnetism.

Refer to the documentation supplied with the magnet for the size of a typical 5-gauss stray field.
Check if this gauss level is checked after the magnet is installed.

ACAUTION Keep the computers (PC) beyond the 5-gauss perimeter of the magnet.

Avoid equipment damage or data loss by keeping PCs away from the magnet. Generally, keep
the PC beyond the 5-gauss perimeter of the magnet. Refer to the Pre-installation Instructions for
magnet field plots.

ACAUHQN Check helium and nitrogen gas flow meters daily.

Record the readings to establish the operating level. The readings will vary somewhat because of
changes in barometric pressure from weather fronts. If the readings for either gas should change
abruptly, contact qualified maintenance personnel. Failure to correct the cause of abnormal
readings could result in extensive equipment damage.

Take electrostatic discharge (ESD) precautions to avoid damage to
CAUTION sensitive electronic components.

Wear grounded antistatic wristband or equivalent before touching any parts inside the doors and
covers of the spectrometer system. Also, take ESD precautions when working near the exposed
cable connectors on the back of the console.

Electrical Hazards
e Disconnect the instrument from all power sources before removing protective panels to
avoid exposure to potentially dangerous voltages.

e When itis necessary to use a non-original power cord plug, make sure the replacement
cord adheres to the color-coding and polarity described in the user guide and all local
building safety codes or local electrical legislation.

o Replace blown fuses with fuses of the size and rating stipulated on the fuse panel or in
this user guide.

e Replace faulty or frayed power cords immediately with the same type and rating.

e Make sure that voltage sources and line voltage match the value for which the instrument
is wired.

Compressed Gas Cylinders

e Store and handle compressed gases carefully and in strict adherence to safety codes.
e Secure cylinders to an immovable structure or wall.

e Store and move cylinders in an upright, vertical position. Before transport, remove
regulators and install cylinder cap.



1.8

1.9

1.10

e Store cylinders in a well-ventilated area away from heat, direct sunshine, freezing
temperatures, and ignition sources.

e Mark cylinders clearly so there is no doubt as to their contents.
e Use approved regulators and connections only.

Safety Hazards of Strong Magnetic Fields

You must understand and plan for the potential safety hazards of strong magnetic fields for
devices, such as certain pacemakers. Check for these hazards after a particular magnet has
been installed.

Cardiac pacemaker wearers must remain outside the 5-gauss
perimeter from the magnet until safety is clearly established. An MR
superconducting magnet generates strong magnetic and

electromagnetic fields that can inhibit operation of some cardiac
AWARNING pacemakers, which could result in death or serious injury. Consult the

pacemaker user documentation, contact the manufacturer, or confer
with a physician to determine the effect on a specific pacemaker.
Varian provides signs with each system to warn pacemaker wearers of
this hazard.

Pacemakers

Cardiac pacemaker wearers must not enter a zone that would subject a cardiac pacemaker to a
magnetic intensity that could cause adverse effects. In some instances, this zone might include
space on the floors directly above and below the magnet. For assistance in determining the effect
of a system on a pacemaker:

e Consult the pacemaker user documentation
e Contact the pacemaker manufacturer
e Confer with a physician to determine the effect on a specific pacemaker

Actual levels vary. Check for safety hazards after a particular magnet has been installed.

Magnetic Field Exposure

MR workers are often exposed to high levels of static magnetic fields. No conclusive scientific
evidence exists indicating adverse health effects at current exposure levels.

The 400-MR shielded magnet contains the high-level fields within the cryostat body.

An article by the American Conference of Governmental Industrial Hygienists (ACGIH) entitled
"Threshold Limit Values and Biological Exposure Indices, 5th ed." states the following:

"Routine occupational exposures should not exceed 60 millitesla (mT)-equivalent to 600 gauss-
whole body or 600 mT (6000 gauss) to the extremities on a daily 8 hour, time- weighted average
basis. A flux density of 2 tesla (20,000 gauss) is recommended as a ceiling value."



Chapter 2 VnmrJ Liquids Interface Description

VnmrJ 3 Liquids NMR has an integrated set of tools designed to acquire a series of one and two-
dimensional data sets from a library of pulse sequences for any given sample. Access the
sophisticated experiments for routine use in a fully automated environment. Automation can be
used with or without a sample changer. Regardless of when or how individual datasets are
acquired, the interface tools can view and interact with the data on a sample-to-sample basis.
Use the View menu to access or hide these tools.

File Edit ents  Acquisition Autematien Process Tools Help Menus
[ System Toolbar = e ~| ol - 2E|_FRGTONO1 ¥
Graphics Canvas
Tune | AmayedSpectra
Protocols Frame Yiewport l l
0y
(JLiCHcarr | In(CHhcorr | (HiSellD 0%
System Studies " (HH)Homo2D | s
Usersudies | Commen | Std 1D L Q
1pm)_|
geosY Cosv 20 T Q
] a o =
: A
aD0cosT Dacost 0] Graphics Toolbar 2 v
50| A
TOCSY ZTOCSY 1o0.] ‘l
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CARBON_01 £:38 Start [Acquire [Process | [Seup Haduais| clearsampleinto | | show Time Parameter Panel
APT_01 850
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gHSQCAD_01 8:17 gh‘m_r sample Name: |2€T Sample Status _ Findzo0 |
gHMECAD_01 [09:28 AM] Pin/Temp! | samplenir 26120100104 01 Insert _ Eject | Gradient Autoshim
gCOSY_01 [11:09 AM] Lot Nurmber: | rage: | Spin | at Hz [] | 2 OneProbe PAK Ik _2009-12-23
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: t
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Comment LOCK: Regulated When: Mewer -
Applab YNMRS 5-1 [=] Level. 48.9 Shim methad: ~ z122 -
OneNMR Probe 3
PAK 100104 I~
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Figure 1 VnmrJ Liquids Interface Window



2.1

Sections in this chapter include:

2.1 Menus

2.2 System Toolbar
2.3 User Toolbar

2.4 Protocols

2.5 Graphics Canvas
2.6 Graphics Toolbar
2.7 Parameter Panel
2.8 Hardware Toolbar

Menus

Standard menu items display at the top of the VnmrJ window. Each of the menu items are
described in order of appearance in the interface, left to right.

2.1.1 File Menu

File Edit View Experiments

Mew Worlkspace

Join a NEW Workspace
Open...

Sawve as...

Auto Sawe

Printers...

Print Graphics...

Auto Plot

Create a Plot Design...
Review pdf Plots..,

Switch Operatars...

Exit Wnmr)

ltem

Description

New Workspace

Creates a new workspace for use. Workspaces are called expl,
exp2, and so on, up to exp9999. A workspace is simply a directory
where data is acquired or processed.

Join a NEW Workspace

Creates a new workspace and then actively join that in the
interface.

A command line equivalent could be cexp(7) jexp7 to create and
join exp7.

Open

Leads to a graphical tool for opening files

Save as

Opens a graphical tool wherein you can explicitly specify the
location and name for saving the data in the current workspace.

10




Auto Save Saves the data that has been acquired in an experiment workspace
using the template set up in User Preferences. See Templates Tab.
The location and file name are automatically set based upon the
values defined in the Preferences Templates tool.

Printers. Allows the user to select a valid printer and/or plotter for output
Print Graphics Prepares a graphics file in any desired format for saving to disk
Auto Plot Calls the appropriate automatic plotting routine for any type of data

in the current workspace

Review pdf Plots Allows you to review the pdf plot in Adobe Acrobat.
You can set the user preference to create a pdf plot automatically
for data that has been acquired of a given sample.

Create a Plot Design Opens the JDesign plot tool for creating plot designs or outputting
with same.
Switch Operators Allows the current operator of the system to logout during

automation thereby freeing the system for use by another operator.

Exit VnmrJ Executes an orderly exit of the VnmrJ program. It is equivalent to
typing exit in the command line.

2.1.2 Edit Menu
Edik View Experiments Ac

Mowve Parameters...

Maowe FID...

Mowve Text..,

Mowe Display parametars...
Mowe Integral resets...

Mew Pulse Shapes (Pbox)..
View Pulse Shapes...
Mew /[Edit Macrao..,

Tool Bar...

Display options...
Edit config profile...
Parameter Pages...
Viewports...
Applications...

Preferences,.,

Systerm settings...

The available commands and options depend on the rights assigned by the VnmrJ Administrator.

Each of the following menu options opens a dialogue that prompts the user to enter the source
and destination workspaces of the items. The command and parameter reference refers to these
tools as mp, m¥, mt, md, and mz.

11



Item

Description

Move Parameters...

Opens the Move Parameters window that allows parameters to
be moved from one experiment number / workspace to another.

Move FID... Opens the Move FID window to move an FID from one
experiment number / workspace to another.

Move Text... Opens the Move Text window to move text from one experiment
number / workspace to another.

Move Display Opens the Move Display Parameters window to move display

parameters... parameters from one experiment number / workspace to another.

Move Integral resets...

Opens the Move Integral Resets window to move integral resets
from one experiment number / workspace to another.

New Pulse Shapes
(Pbox)...

Opens the powerful Pbox tool for the creation of pulses and
decoupling shapes.

View Pulse Shapes...

Opens the Pulse tool, a Bloch simulator for viewing the effects of
any shaped pulse.

New/Edit Macro...

Opens a macro directly in a text editor.

Tool Bar... Enables the addition of a button to the top bar of the user
interface with a user-specific function.
Display options Opens a graphical interface from which you can modify and

save/recall the colors used in every tool used in VnmrJ.

Edit config profile...

Allows modification of what experiments are shown in the
Experiment Selector tool.

The starting point is based on the profile assigned to them by the
VnmrJ administrator

Parameter Pages

Enables you to build/modify Parameter pages.

Viewports... Enables you to toggle viewports.
It is a tool to view multiple workspaces simultaneously, on or off
Applications... Enables you to define an account with collections of Applications

Directories.
An Applications Directory is simply a path to a specific directory
that could contain macros, parameter templates, and so on. For
example, the AutoTest facility can be toggled on or off with this
menu item.

Operator Preferences...

Enables the account administrator to allow the individual
operators to manage their own preferences for the interface to
automatically preset items as email address, preferred solvent,
plotter, or notebook.

In this example Operator Preferences is not active because in the
Preferences menu User Remembrance is not enabled. The list of
choices for this list is completely general and is defined by the
account administrator.
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Preferences... Enables the account administrator to define items such as data
saving template and default behaviors for plotting, automatic
creation of pdf plot files, and a number of operator privileges.
This is an important menu item and is discussed in detail in
“VYnmrJ 3 Preferences.”

System Settings... Opens a graphics tool with which many system options are
defined

2.1.3 View Menu

Use this menu to access parts of the interface and restore the interface elements. Close the
window by clicking the Close button in the upper right hand corner of each window. Access the
hardware or graphics toolbars using the Toolbars submenu.

Yiew Experiments Ac

Command Lina
Pararneter Panel
Experiment Selactor
Study Queaue

Frarme

Yiewpaort

10

20

Cryo

Tune

ArrayedSpactra
Taoolbars 4

Systemn Toolbar
User Toolbar
Craphics Teolbar

T R R R

Hardware Toaolbar

2.1.4 Experiments Menu

Unlike the Experiments Selector which can be configured by both the administrators and
individual operators in terms of content, the Experiments menu shows the full selection of
experiments accessible for the account. Do not perform automation submissions from this menu,
use the Experiment selector tool.
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Experiments Acquisition Automation
Setup NEW parameters for ..

Protan

Carbon

Fluarine

Phosphorus

Other Nucleus »
H1 Relax, Measurements >

Convert current parameters to do ...
Standard 1D experiments

Solwent Suppression - Select peaks
Hemenuclear Correlation Experiments
Indirect Het, Corr. (Basic)

Indirect Het, Corr. (More..)

CRISISZ Experiments

Selective Excitation Experiments

#—H Multiplicity Determination
Heteronuclear Correlation

Relax. Measurements

DOSY Experiments

r W w T W T wT w wT v w

Hadamard Experiments
Solid-5State Experiments J

Use the submenus and the menu options to perform the following tasks:

Iltem

Description

Setup NEW parameters for...

Executes a simple retrieval of standard parameters for
the selected experiment and also completely clears all
sample tags (parameters used to define a sample’s
identity).This is a clean slate.

Convert current parameters to do...

Sets up the selected requested experiments but retains
all sample tags.

If you choose to use the Experiment selector without first
requesting New Study by the Study Queue controls the
result is the same as this conversion. The conversion of
parameters with retention of sample identification
parameters is the modality of “more on this sample.” The
acquired data is auto saved and added to the pre-
existing data acquired the current study

Setup NEW parameters to do..

Allows a simple retrieval of default parameters for all 2D
and a few 1D experiments, according to your need.
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Hadamard Experiments

Provides access to all of the Hadamard Fast methods
2D experiments.

DOSY Experiments

Allows access to DOSY experiments, if you want to
acquire locally in a workspace, provided the license for
DOSY is installed.

DOSY experiments are also an optional part of the
Experiment Selector.

Solid State Experiments

Allows access to all routine Solids NMR experiments

2.1.5 Acquisition Menu

The Acquisition menu provides a convenient non-command line access to a number of core
VnmrJ commands such as go, ga, or au.

The menu option, Parameter Arrays, facilitates the creation of parameter arrays.

Acquisition Automation Pr

Parametesy arrays...

findz 0

Do Gradient Shimming... F*
Acquire [go]
Acquire/exacute wexp
Acquire/Process
Acquire/Process/Save
Acquire/Process/Plot
Acquire/Process/Plot/Save
Setup Hardware [su]

Set Shims Into Hardware

Abort Acquisition

2.1.6 Automation Menu

Use the Automation menu to access features other than the process of sample submission.
Access is not needed for typical submission of samples in sample changer-driven NMR

experiments.

Automation|Erocess Towols H

Automation Queue
Autormation Run (autodir) 4
Autermation File (globalenter) ¥
Tray Actions.. 4
Tray archives

Submit current params to. »

Automation Controls.. ’
Foreground Acquistion.. »

Show current acglog

Show realtime acglog

Automation Queue

Displays the Automatin queue.
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Automation Run (autodir)

Provides graphical tools to create a new automation run or to begin the submission process. Most
VnmrJ 3 sample changer access is done on demand by using Study Queue controls or the tools
in the Automation Run submenu. The user can also create a list of experiments for a set of
samples that will not immediately run and can be saved until the account administrator activates
the actual acquisition process.

Automation File (global enter)

Use the Automation File submenu (global enter) to achieve the delayed mode of sample changer
NMR.

AutomationlErﬂcess Tools Help

Automation Queue

Automation Fun (autodir) k

Automation File (globalenter) P MNew Study

Tray Actions.. ¥ Mew Automation File
Tray archives Show AutoFile Tray
Submit current params to. P Submitto Acquisition
Automation Controls.. *I

PHMOQC Index; 965
Foreground Acquisition.. J

Show current acglog

Show realtime acqglog

Tray Actions

Tray Actions provides functionality that is also available on the Study Queue controls. The labels
of the menu options are self-explanatory.

Automation|Erocess Teols Help

Automation Queue

Automation Run (autodir) 4

Automation File (globalentar) ¥

Tray Actions., M Show Tray

Tray archives Hide Tray

Submit current params to.. * Show All Studies
Automation Controls.. ¥ Automation Run Status

F d A . N Show Study from a Location
oreground Acquistion. Recall and resubmit Study from a Lo cation
Show currant acglog Recall and edit Study from a Location

Show realtime acglog

Tray Archives

Tray archives allows the user to browse completed automation runs from other dates. If the
sample submission is not accessible in an old completed automation run, Tray archives will not
proceed.

Submit current params to...

Use to manually build any desired experiment in the current workspace and to submit to an
automation queue, both day and night.
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Automation|Erocess Tools He

Automation Queue

Automation Run (autodir) 4
Autemation File (globalentar) b
Tray Actions., 4

Tray archives

Submit current params to.. | Automation Run as a study to DayQ

Automation Controls.. »| Automation Run as a study to NightQ

Automation File as a study to Day(

isti »
Foreground Acquistion. Autornation File as a study to NightQ

Show current acgleg

Show realtime acqlog

Automation Controls

Automation Controls contains powerful tools to interact with the running automation queue in real-
time.

Automation|Erocess Tools He

Automation Queue
Automation Run (autodir) 4
Automation File (globalenter) ®
Tray Actions.. 4
Tray archives

Submit current params to..

Automation Controls.. P Pause after current Study

Fereeame Awpisies y| Pause after current Acguisition

Stop-Save-Resume
Show current acqlog Stop-Discard-Resume
Show realtime acqglog Sisp=Save

Stop-Discard

Pause MOV

Pause at scheduled time...
Resume Autormation

Abort Autornation

Item Function

Pause after current Study To pause the automation run, manually run an emergency
Pause after current sample, resume the automation run, or to pause a run to fill
Acquisition the magnet with cryogens.

Double click the active node in the Study Queue window to
combine submenus with the ability to process automation data
as acquired in real time.

Stop-Save-Resume Stops the running experiment, process or plot, or save to
move on to the next experiment in the chain or queue.

For example, if a 4 hour experiment were running in
automation and after 30 minutes it was processed and nearly
complete, then this action allows you to choose a rational
action at that time.

Stop-Discard-Resume Stops the running experiment and move on to the next item
on the list.

Stop-Save and Stop-Discard | Functions exactly as the submenus described above except
that the queue is not resumed until you select Resume
Automation from this submenu.
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Pause NOW

Allows you to pause the experiment immediately.

Pause at scheduled time

Allows the administrator of the account to define in advance
an exact time for the automation run to be paused along with
a time for automation to resume.

During the time of pausing you can use the interface to submit
more samples and to acquire NMR data manually. You can
also allow time for cryogen fills and the magnet time to
recover. The automation run can resume automatically.

Resume Automation

Resumes any paused automation run.

Foreground Acquisition

Allows user to pause after current acquisition, pause immediately, or resume paused study.

Autornation Procesz Tools Help

Automation Queue
Automation Run (autodir) » |
Automnation File (globalenter) ¥ |

Tray Actions., » |

Submit current params to.. *

Automation Controls.. ’

Foreground Acquistion.. »

Show current acqlog

e T —

Show realtime acgleg

Show current acglog

Displays the current acglog in a popup window.

Show realtime acqglog

Displays the realtime acqglog in a popup window.

2.1.7 Process Menu

The Process menu provides tools for common tasks as an alternative to the command line.

Process Teools Hzlp

Process and Display 1D
Full Procass

Drift Correct Spectrum
Automatically Set Integrals
Baseline Correct

Set Transmitter at Cursor
Add and Subtract 10 Data

Full Process 20
Process 20 (Individual Steps)

Analyze

Set Spectral Width betweean Cursaors
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Item

Function

Process and Display 1D

Process and display 1D data.

Full Process

Process and display 1D data using the processing associated
with the protocol.

Drift Correct Spectrum

Apply drift correction along both axes of a 2D data set.

Automatically Set Integrals

Automatically find and set integral regions.

Baseline Correct

Apply baseline correction.

Set Spectral Width between
Cursors

Mark new spectral width on the graphics screen using the left
and right cursors and set the new spectral width.

Set Transmitter at Cursor

Mark new transmitter location on the graphics screen and set
the transmitter.

Add and Subtract 1D Data

Results are shown displayed in current when second
spectrum is selected.

Clear Buffer and Add Current Spectrum

Add Second Spectrum Inte Buffer
[ |

Full Process 2D

Process and display 2D data using the processing and display
parameters associated with the protocol.

Process 2D (Individual Steps)

Step by step processing of 2D data.

Analyze

Cosy Correlations...
sSpin simulation...
Deconvolution...
Fegression..,
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2.1.8 Tools Menu

Tools Help

Study Clones..,

Study Queue Actions..,
YWorkspace Information..,
Probe Tuning

Standard Calibration Experiments

Update Locator
Import Files to Locator...
Sawve Custorm Locator Statermnsnt..,

[elete Custom Locator Statement...

Maolacular Structureas
Change Password..,
Browser..,

Locatar..

Salect Optional Files...
Sample in Magnet..,
Yiaw Cryogens...

Convert pre=%nmr] 3.0 data ...

Item

Function

Study Clones...

See below Table 1 Study Clones...

Study Queue Actions...

See below Table 2 Study Queue Actions...

Workspace Information...

See below Table 3 Workspace Information...

Probe Tuning

Displays option to tune probe:

Auto tune setup...—Opens the Setup AutoTune window.
Tune Probe...—Opens the Tune Probe window.

Manual Tune Probe—Loads manual tuning parameters and
panels.

Standard Calibration
Experiments

Provides the interfaces for probe calibration and gradient
shimming setup:

Probe Calibration—Opens a window for running a series of
experiments to calibrate the probe.

Set Up Gradient Shimming—Loads the pulse sequence and
panels for making a shim map for gradient shimming.

Set Up 3D Gradient Shimming—Selection appears only if this
option is installed. Loads the pulse sequence and panels for
making a 3D shim map for gradient shimming.

Update Locator

Opens a submenu that provides choices for updating the
different parts of the Locator.

Import Files to Locator...

Opens a window for importing files to the Locator.

Delete Custom Locator
Statement...

Opens a window for deleting custom locator statements.
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Molecular Structures

Display all—Display all molecular structures.

Plot all—Plot all molecular structures.

JChempaint...—Opens the open source application
JChempaint in a separate window. Refer to the online manual
provided with Jmol.

Change Password...

Opens a window for changing operator passwords. If the
operator has an operating system login account, the password
will also be changed.

Browser...

Opens a file browser window.

Locator...

Opens a Locator and File window.

Select Optional Files...

Additional files that can be automatically saved in the .fid
directory.

Sample in Magnet...

Tool to command sample changer to change sample and to
assign sample position currently in magnet.

View Cryogens...

Tool to monitor cryogens. For more information see the
Cryogen Monitoring user guide.

Convert pre-VnmrJ 3.0
data...

Tool to convert pre-VnmrJ 3 data for use in VnmrJ 3.

Study Clones Submenu

The Study Clones submenu is a group of convenience utilities.

A Study Clone is a set of experiments built in the Study Queue with any desired parameter
customizations. This set of experiments is automatically represented as a hew button in the
Experiment Selector. After creation, the user can repeat the exact set of experiments simply by

selecting that button either in or out of automation and with or without a sample changer. One use

of a Study Clone is to set the desired parameters for a very fast PROTON spectrum, such as

nt=1 ss=0 gain=4 and Clone current Exp with a button label Fast_H. It might also be useful to

set parameters for a slow quantitative PROTON experiment such as d1=60 pw(90) ss=2
nt=8 and Clone current Exp with a label as Quant_H. The user can use the Study clones to
recall complex sets of multidimensional experiments or to simply establish a convenience button
for commonly done tasks. Clones from other clones can also be created by adding more
experiments in any desired fashion.

Clane Currant Study

Clone Current Experiment
Clone Location Queus
Command and Protocol Buttons
Edit Parlik...

show Libsrary...
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Table 1 Study Clones... Submenu

Item

Function

Clone Current Study

Use to assign a name for the button associated with a study of
a list of experiments assembled in the Study Queue.

Clone Current Experiment

Allows user to assign a name for the button option associated
with the currently loaded or displayed experiment. For
example, use this option if an FID from a previous study is
retrieved in the current workspace, and the user wants to
create a clone of the single experiment that had been
acquired on that sample.

Clone Location Queue

Allows creation of a button associated with the study
completed for the selected tray sample location.

Command and Protocol
Buttons

Use the Protocols menu option to devise a method to create a
button to run an old-fashioned macro to setup an experiment.

In the Type field, select either Experiment or Command.

If Command is selected, a button option is created to call a
macro that for example, analyzes the lineshape. Based on the
result, the user can decide to call a group of non-spin shim
routines. A Study Clone could then be composed of a
PROTON experiment customized appropriately for running 1H
lineshape, followed by the command protocol to analyze
lineshape in the Study Clone. This Study clone can be
submitted at any time and automates the task of refining

shims.
®  Protocol

My Library: My Library:

Type: [ Experiment  [¥] Cammand

Name: |mymacro

Type: [l Experiment (] Command
Name: FROTON
Group: tdi0 Group: 000
Action: || Execute. PROTON Action: [v] Execute., [rymacro

[ "] Recall current parameters (rip) (] Recall curren parameters (mp)
ExpTime: Mot Applicable

Make protocal |

ExpTime: 29 sec

Make grnm(_s J

T i T T 1
Close || Abanden | Edi H Und ‘ Close ‘ ban

Edit Parlib...

Enables users to view the details of any valid VhmrJ 3
protocol. Edit/Make parlib can also create new protocols
based on the contents of the parameter set in the current
workspace.

Use the Study Clones tool to create a modified version of an
already existing protocol, such as PROTON or CARBON
experiments with specific parameters for a quick or long
experiment; do not use Edit/Make Parlib. In order to properly
utilize the tool, the user must have a basic understanding of
the concept of modules and locked parameters (Plock).
Following is an example view of Edit/Make parlib for a band-
selected 2D experiment.
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Edit/Make Parlib Ll

Custom Parlib/Exp: (ExpType: bsHSQCAD)

Name |bsHSQCAD

apptype: hetero2D
modules; 25at wet gradient Dch_adiabatic dpfgse impress sel2D

Lock parameters... [dm ni nt seltype shapel80
By default, start with.. |HSQCAD gHSQCAD HSQC gHSQC wetlD PRESAT PROT
(Queued acquisition onit)

Customization:

|if (satmade ='y) then
| satmode="y/
|endif

User Customization:

{macro format - overrides all defaultsy

Save/update Remaove

Close

Both the apptype and the list of modules are different from the
PROTON protocol. The user can query the values and
modules for the apptype parameter by using the apptype? and
modules? commands before creating a new protocol from a
pulse sequence and parameter set that originated from
outside VnmrJ 3, such as the user library. Assign the value for
modules to the Lock parameters list and add any parameter
needed to be kept at setup time.

In the above PROTON experiment, basic protocols include the
following key concepts:

Name—Displays the name of the set parameter and the
protocol’s button.

apptype—Displays a generic helper macro nhame for setting
up a group of protocols. In VnmrJ 3 apptype is optional.
Common apptypes are std1D, homo2D, hetero2D, and
Istd1Dmodules. The names for the little min-parameter sets
that are combined to create the existing parameter set.
module—Displays a module and all of the values for the
parameters in that module, type on the command line module
(‘popup’,’modulename’), for example module
(‘popup’,’presat’).

Default Starting Experiment—Define a default experiment as a
starting point to morph the default experiment into the desired
experiment. Type REQexp? from the command line to query
the value for the default starting experiment.
Customization—Shows the contents of the macro
name_setup or in the case of this example PROTON_setup.
Not editable in this tool but it can be edited in a text editor.
User Customization—Creates a macro from the text typed in
this field. userprotocolname or for this example userPROTON

Show Library

Opens a graphical tool to backup then remove old buttons and
to review the executable actions of buttons.
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Study Queue Actions...

Fefresh StudyQueue
Clear StudyQueue

Table 2 Study Queue Actions...

Iltem Function

Refresh StudyQueue The menu options in the Study Clones submenu are
Refresh Study Queue: Updates the study information in the
Study Queue pane.

Clear StudyQueue Clear Study Queue: Clears the Study Queue pane.

Workspace Information...

Workspace Information
Exp# Status Size Sequence Text
EXPL (PARAMETER) 108 CARBOMN Probe tuneing parameter
ExP2 (PARAMETER) 52 stellh STAMDARD 1H OBSERVE
EXP3 (PARAMETER) 52 stlh STANDARD 1H OBSERVE
EXP4 (PARAMETER) 52 stellh STANDARD 1H OBSERVE
EXFPS (FPARAMETER) 52 stdlh STANDARD 1H OBSERVE
EXP& (PARAMETER) 52 PEOTOM STANMDARD 1H OBSERVE
Current Exp# 1 Create & join NEW Exp |
E #] i
Refresh Information | = Loi
Exp# Delete
! Edit.. || Undao || Cloze H Abandaon |

Table 3 Workspace Information...

The Workspace Information menu displays the status of all

Workspace Information... .
workspace ongoing processes.

2.1.9 Help Menu

Help
Online Manuals (POFD...
Online Manuals (HTML)...
YWarian, Inc MMR Home Page...

About Yamrl...

Item Function

Online Manuals (PDF)... Opens manuals in PDF format.
Online Manuals (HTML)... Opens manuals in HTML format.
Varian, Inc NMR Home Page... Opens the Varian NMR home page.
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2.2 System Toolbar

REFESE WLl Jzamorouo <]
The system toolbar provides access to common functions.

2.3 User Toolbar
L.
Save the current screen layout: graphics, parameter panel, locator sizes.

2.4 Protocols

Use the Protocols menu option to devise a method to create a button to run an old-fashioned
macro to setup an experiment.

2.4.1 Experiment Selector

When an experiment is selected in Experiment Selector, all submissions to automation can be
selected. Configure families of experiments and content by using the Experiment Selector. Simple
or complex experiments, based on an account or an operator within an account, are accessible
as needed.

Protocols |/ Frame |/ Viewport |/1D |

I1(CHycorr | In(CHycorr | (HISellD |
System Studies [ (HHHomo2D
Lseratudies r Carnman |/ ard 1D

‘ gCosY COSY

‘ aDQCOsY DQCOSY

‘ TOCSY ZTOCSY

‘ MOESY ROESY

‘ ROESYAD

2.4.2 Study Queue

VnmrJ 3 allows the ability to construct a linked list of experiments as a Study Queue, that can be
performed on any given sample. For more information, see Chapter 4 Studies.

Use New Study or Continue Study to process sample submissions. New Sample can also be
used to process sample submission.
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Study Quewe
YView: Sample LI

e 2E1_20100104_01
2EI_PROTON_01
2EI_CAREON_O1
2EI_APT_01
2EI_DEPT_01
2EI_HSQCAD_01
2EI_gHSQCAD_D1
2EI_gHMECAD_01
2El_gCOSY_01
2EI_gDQCOSY_01
2EL_TOCSY_01
2EI_NOESY_01

New Study Continue Study

2.5 Graphics Canvas

The Graphics canvas is used to display and interact with graphic and text information. For more
information, see 5.4 Interact with the spectrum using the graphical toolbar.

Index: 1 &
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Graphics Toolbar

The Graphics toolbar is used to control the interactive display in the graphics
canvas. For more information, see 5.4 Interact with the spectrum using the
graphical toolbar. "

|

ogd

TS

b

Parameter Panel

The Parameter panel is below the graphics window and above the Hardware toolbar. The
Parameter panel shows the pulse sequence, context-specific information, menus, and text entry.
The panels under the Acquire and Process tabs change on a pulse-sequence to pulse-sequence
basis. Parameter panel information is made for the experiment being set up or processed.

T X

Start Acquire| Process| Setup Hardware| ClearSamplelnfo | Show Time _
Standard Operator : vamrl Logout
Lock
Shim sample Name: |2ET Sample Status Find z0
Spin/Temp| | camplenir 2E.20100104_01 Insert  Eject | Gradient Autoshim_ |

Lot Mumber: | Page: | Spin_|at |0 Hz [ ] ||2 OneProbe PAK Ik 2009-12-23

hatebook [ Eaddr. | Temp |at[z5.0  C Autolock

Salvent cDCI3 ] Spin:  Off wihen: Mot used -

olven =

DMSO ChCl3 D20 Other Rate: O Hz Lock Autoshim

Comment LOCK: Regulated hen: Mewer -

Applab YRMRS 5-1 || Lewal: 489 Shim method 2122 -

OneMME Probe i

PAK 100104 -

261867 =

%

Each pane can be resized, reduced to a tab, or closed. Setup, acquire, or process NMR data
using the point and click feature of the interface. The interface can also be accessed using the
command line, above the large graphics window. There are three tabs labeled Start, Acquire, and
Process below the graphics window. The top page on each tab displays commonly used
functions. Lower pages displayed detailed functions. Buttons below the Graphics window and to
the right of the tabs represent tab-specific actions and differ with each tab.
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2.8

Hardware Toolbar

The Hardware toolbar, located at the bottom of the VnmrJ window, shows a trash can icon and a
display area dedicated to real-time hardware information.

Temp Spin Lock | Sample m ﬂ| Inactive O |Executing CAREOMN
I techpubs
(@] [ vom ]

Sample temperature, spin rate, lock level, and current sample changer location are displayed to
the left of the Hardware toolbar. If the user is logged in as an administrator, the probe files are
displayed next to the toolbar. Real time events such as system is idle, locking, shimming, or
acquiring data are displayed in the field located to right of the probe file. If the system is active,
each event's remaining time is displayed. To the right of the Hardware toolbar is a system
message box.
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Chapter 3 Prepare and Load Samples

3.1

Sections in this chapter include:
e 3.1 Preparing the Sample
e 3.2 Ejecting and Inserting the Sample

How samples are prepared and positioned in the turbines greatly influences how reliable and fast
the data accumulation is from multiple samples and how auto shimming is performed. The
discontinuities in the bulk magnetic susceptibilities at the various interfaces (air-to-glass, glass-to-
solvent, and solvent-to-air) can generate a lot of line-broadening variability from sample-to-
sample, regardless of whether automation or manual operation is used. The time spent
shimming, or the need to shim, is largely dependent on the care used to control the effects of
these discontinuities.

Preparing the Sample

3.1.1 Solvent Selection

Although samples are typically run as solutions, they can also be run as neat liquids. The
solvents used to make up solutions should be inert (does not react with the sample) and ideally
available in deuterated form. Resolution is better with a deuterium lock, especially for lengthy
accumulations. The instrument can be run unlocked without locking onto the deuterium of a
deuterated solvent. Commonly used solvents are deuterated versions of chloroform, DMSO,
water, acetone, and methylene chloride.

3.1.2 Solute Concentration

A typical NMR sample contains the solute in 1:100 mM concentration. Because the signal-to-
noise of an NMR spectrum increases as the square root of the time of the experiment, halving the
sample concentration increases the required time four-fold. The minimum sample concentration is
often controlled by the minimum sample height, see Sample Height, which is more critical to
optimize than the sample concentration. Sample concentrations of up to 100% can be used in
NMR, but unusual spectral effects may occur. Typically, “dilute solutions" are used.

3.1.3 Solution Preparation

Filtration

Samples for solution-state NMR should be homogeneous liquids. Samples that contain
heterogeneous material in the tube, solids, bubbles, or immiscible liquids exhibit broad NMR
lineshapes, and this broadening cannot be shimmed out. Such samples should be filtered before
use, if high-resolution spectra are desired.
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Salt

Samples of increased ionic strength detune the probe and cause reduced signal-to-noise. The
probe may need to be retuned for these samples, to improve both the signal-to-noise and the 90-
degree pulse width, but not back to the original values.

3.1.4 Sample Height

To minimize bulk magnetic susceptibility discontinuities at each end of a sample (the "end
effects”), the liquid column length of the sample must be at least three times the length of the
observe coil. This suggests a column length of close to 50 mm for most modern probes. Solvent
volumes of 0.6 ml in a 5-mm tube (and 3.1 ml in a 10-mm tube) are adequate for removing the
end effects. (The 50-mm length is ideal for 5-mm tubes in 5-mm probes. The 10-mm probes are
particularly sensitive to shorter column heights. The 3-mm probes are less sensitive about
maintaining this sample height as compared to 5-mm tubes and probes.)

Signal-to-noise cannot be increased by reducing the sample volume to attain higher
concentration; shorter samples produce spectra with broader lines. Typically, a 0.4 ml sample
generates a spectrum with a lower signal-to-noise than the same solution diluted to 0.6 ml.
Shorter samples take longer to shim and require more re-shimming between each sample. (All
samples have some variability in sample volume. The amount of re-shimming needed to
compensate for this variability is more pronounced in 0.4 mL samples than in 0.6 to 0.8 mL
samples. This problem gets worse if the samples get much shorter than 0.5 mL.

For best results and minimum shimming time, samples should be prepared to be of similar
heights. As long as the bottom of the tube is positioned properly, there is little sensitivity to
sample length above 0.7 ml. The user should make every sample up to the same height and
obtain shim values using samples of that height.

For Wilmad 528 or 535 tubes with no restricting plugs, samples containing the volumes listed in
Table 4 should be placed at the depths shown in that table. Depth is the distance from the bottom
of the standard spinner turbine to the bottom of the sample tube.

Table 4 Sample Tube Depths

Volume Length Depth (Range)

700 pL 50 mm 68 mm (65-69 mm)
600 pL 42 mm 65 mm (63-67 mm)
500 pL 36 mm 62 mm (60-64 mm)
400 pL 28 mm 59 mm (59-62 mm)
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3.1.5 Sample Position

Use the sample depth indicator provided with the spectrometer to set the sample position to a
repeatable position. Note that each spinner turbines accept only one size tube. There are spinner
turbines designed for 5-mm tubes, as well as for 10-mm, 4-mm, 3-mm, and 1.7-mm tubes.

T

Figure 2 Sample Depth Gauge

To Position a Sample Using the Depth Gauge

1. Carefully insert the NMR sample tube into the spinner turbine by inserting the tube into
the wider top side of the turbine.

NOTE: Do not place your hand under the hole in the bottom of the spinner turbine, as the sample
tube will protrude from this opening when the sample is correctly positioned in the turbine.

2. Put the sample-turbine assembly into the top of the depth gauge, and push the assembly
down gently until it rests on the bottom of the depth gauge.

Because the position of the bottom plug within the depth gauge is adjustable by users,
take note of the depth (in mm) that the plug is currently set to, and ensure that is the
value recommended by the local NMR administrator.

3. If you need to use less than 0.7 ml of solvent for any reason, you can center the liquid
volume in the cross-hatched area. This centers the sample in the receiver coll, indicated
by the center line symbol.

3.1.6 Sample Tubes

Buy the best quality NMR sample tubes, and clean the outside of each tube with a solvent such
as isopropyl alcohol. Cleaning should be followed by a careful wiping with a wiper tissue before
placing the tube in the probe. This helps keep the inside of the magnet bore (the "upper barrel")
clean, to make the sample spinning more reliable (when needed). The use of good quality sample
tubes is especially important when the sample spinning is used. Low quality sample tubes often
generate larger spinning sidebands, or scratch the inside of the probe.
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3.2

Ejecting and Inserting the Sample

All modern spectrometers have an automatic insert and eject feature. The spectrometer is
equipped with hardware and software to provide computer control of sample ejection, insertion,
spinning, locking, and shimming. This section covers computer-controlled sample ejection and
insertion.

Manual control of ejection and insertion is also provided on each of these systems to enable the
user to withdraw samples if necessary. Although it is recommended that the user rely on
computer control.

NOTE: Solids probes do not support sample insertion and ejection.

3.2.1 To Eject a Sample, Without a Sample Changer

Always eject first, even if no sample is in the magnet, to start the airflow for carrying the sample.
After ejection air is turned on and under computer control, if the sample is present it will rise back
to the top of the upper barrel. Remove the sample, and replace it with another sample.

Using the Command Line
Enter e (or enter) in the command line.

Using Automation
If you have a sample changer (7510-AS, 7600-AS, Carousel, or SMS), the sample is changed
automatically under computer control (in the sample order listed in the StudyQ).

Manual Ejection

This is applicable for the VNMRS and 400MR systems only.
Flip-up the switch on the top of the upper barrel (located on the top of the magnet bore) to eject
the sample.

3.2.2 To Insert a Sample, Without a Sample Changer

When inserting a sample, the sample tube gradually lowers down the upper barrel under
computer control.

Using the Command Line:

1. Perform a sample ejection (even if no sample is in the magnet) to start the airflow for
carrying the sample.

2. Insert the sample by placing it in the top of the upper barrel.
3. Enter i(or insert) in the command line.
Using Automation

If you have a sample changer (a 7600-AS, a Carousel, or an SMS), the sample is changed
automatically under computer control (in the sample order listed in the StudyQ).

Manual Ejection
This is applicable for the VNMRS and 400MR systems only.

Flip-down the switch on the top of the upper barrel (located on the top of the magnet bore).
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3.2.3 To Change a Sample, With a Sample Changer

The Sample in Magnet tool is located in the Tools menu. This tool allows samples to be removed
or inserted by a robot sample changer. It can also be used to specify the tray or slot location for a
sample in the magnet.

|.! Sample in Magnet x|

Magnet has sample &7 (T2 D1)
Assgign sample location {input as integer) I
[ ] Remowe sample fram magnet

Fut new sample into magnet {input as integer) I

0] 4 Canceal Help

Figure 3 Sample in Magnet Tool

To remove a sample from the magnet:
1. Selectthe Remove sample from magnet check box and click OK.
To insert a sample in the magnet:
1. Putthe sample into the robot sample holder.
2. Type the location into the Put new sample into magnet box and click OK.

3. To designate the tray location of a sample in the magnet, type the desired location into
the Assign sample location box and click OK.
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Chapter 4 Studies

4.1

VnmrJ 3 allows the ability to construct a linked list of experiments as a Study Queue, that can be
performed on any given sample. When data is collected using the Study Queue information
regarding that sample, including raw data, processed data, plots, are linked together and
automatically collected into a Sample Directory. This allows customized information from one
experiment (i.e., calibrated pulse widths, optimized sweep widths, solvent suppression conditions,
etc.) to be automatically incorporated into subsequent acquisitions, and the automatic addition of
high-resolution reference spectra to plots of 2D data sets. The location and structure of each
Sample Directory is controlled by choices made in the User Preferences panel under the
Templates tab, see Templates Tab.

Sections in this chapter include:
e 4.1 Introduction
e 4.2 Operations Using a Robot Sample Changer
e 4.3 Operations Without a Robot Sample Changer

Introduction

A Study Queue can be created, modified, extended, and saved using different tools described in
this chapter. It is important to note that these tools can be applied with or without the use of a
robot sample changer.

The sequence of steps for data acquisition using Study Queues is simple and straightforward.
The process is initiated by clicking the New Study button on the lower portion of the Study Queue
vertical panel. This places the software into “submit mode” where the tools are available to build,
customize, and submit a Study Queue. (In contrast, the other operating mode is “Review mode”
and is used for all other tasks, such as manual data collection, processing and plotting, and so
on.)

While the Study Queue is used to collect data, it also serves other functions. The Study Queue
presents a graphical representation of the status of all experiments submitted to acquisition in the
current automation run. Experiment nodes that have completed are displayed as green, while the
active experiment is blue and experiments that have been submitted but not yet begun are
considered “pending” and are shown in yellow. Double-clicking on a completed node loads the
associated data and processes that data in the current workspace.

Finally, when used on a system equipped with a robot sample changer, the Study Queue can
display an overview of all the studies submitted to automation by choosing View - Spectrometer
from the top of the Study Queue pane. Lists of nodes under the headings of Active Study,
Completed Studies, Studies in Progress, Errored Studies, Priority Studies, Studies in Queue are
displayed, as well as the estimated completion time for each active and pending experiment
node.

The various options and choices available for using the Study Queue mechanism will be
discussed in this chapter.

34



4.2 Operations Using a Robot Sample Changer

The Study Queue pane changes to reflect movement between the two modes of software
operation: Review mode and Submit mode.

View: Sample ;I

New Study Edit Study ‘

Tray: VWMRS_05_Nov_01

Show Stucly from Location ‘

Figure 4 Study Queue—Review Mode

4.2.1 Study Queue Controls—Review Mode
In Review mode, the Study Queue pane is used to display information about the current
automation run.
The View pull-down selects what information is displayed:
e Spectrometer — shows all studies in the current automation run
e Sample — shows the study linked to the data in the current workspace
e Active Sample — shows the study that is currently running

The New Study button initializes a new study and moves the software to “submit mode.” The Edit
Study button allows one to modify the study currently displayed in the Study Queue. The Show
Study from Location button loads a study from the tray display.
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Figure 5 Study Queue—Submit Mode

4.2.2 Study Queue Controls—Submit Mode

In Submit mode, the Study Queue pane is used to build a study and submit it to acquisition.

The Done button abandons any changes made to the current study and returns the software to
Review mode. The DayQ and NightQ buttons explicitly selects when an experiment will be run.
The schedule for when the DayQ and NightQ begin is set by the account administrator through
the Preferences panel, see Automation Tab.

The Priority sample check box allows a sample to be submitted ahead of all other samples in the
current automation run. This feature is controlled by the system administrator on an operator-by-
operator basis.

The New Study button creates a new study.

The Submit button submits the current study to acquisition. The associated pull-down menu
determines how the acquisition is to be performed:

e Automation — submits the study to the Spectrometer Queue.
e Foreground exp — submits the study to acquisition in the current workspace.
e Background — submits the study to a background copy of VnmrJ.

The Edit Study from Location button loads a study into the Study Queue from the tray display in
preparation for modification of that study.

The Clear Pending Exp from Queue button deletes all pending experiments from the current
Study Queue.
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4.2.3

Using the Study Queue — Full Automation

To collect a series of spectra in a Study Queue:

1.

4.2.4

Place the sample in a spinner turbine and adjust its position using the sample depth
gauge. Place the sample/spinner into the robot sample rack and note its position.

Click New Study in the Study Queue vertical panel. This initializes the Study and moves
the software into “submit mode.”

Click on the buttons in the Experiment Selector to add the desired experiments to the
Study Queue. The order of the experiments in the Study Queue can be changed using a
click-and-drag action. Dragging an experiment node to the trash can deletes it from the
queue.

Experimental parameters for an individual experiment can be customized by double-
clicking on the experiment node in the study queue. (This is dependent upon the rights
and privileges permitted for each user by the System Administrator.) The parameter set
is loaded into the current workspace where any desired changes can be made using the
horizontal panels under the “Acquisition” tab. Once the desired changes are complete,
click Save.

Fill in the information associated with the sample, such as sample name, solvent, emalil
address, comments about the sample, and so on. The sample name parameter is
typically required as part of the automatic data saving routine, and the solvent information
is used to determine where the lock must be set to in order to get correct referencing.

Select the checkboxes to control automatic printing, locking, shimming, and tuning, as
appropriate.

Select the location in the tray display that corresponds to your sample. Once selected,
the location will show a flashing highlight ring.

Click Submit. (Depending on the settings in the preferences panel, the system remains
in “submit mode” with the current queue still loaded in the Study Queue window. The
same queue can be submitted to a new sample location by editing the sample
information, clicking the appropriate location in the tray, and clicking Submit again.)

Click Done to return the interface to Review mode.

Day Queue, Night Queue, and Priority Queue

The account administrator can choose to restrict the time available for any given sample.
(See Automation Tab) Depending on preferences chosen by the account administrator,
the Study Queue either moves any experiment that exceeds the time limit into the Night
Queue or will not allow further additions to the study. The user has the ability to explicitly
direct an experiment to occur at night by selecting the “NightQ” radio button in the Study
Queue window before adding an experiment to the study.

If allowed by the account administrator, users can select the “Priority sample” checkbox
before submitting a Study Queue to acquisition. The priority sample will be inserted into
the magnet as soon as the current sample is completed, as compared to being added to
the Spectrometer Queue in the order that the studies were created.
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4.2.5 Editing experiments in a pending study

Until acquisition has begun on a queued experiment, that experiment can be modified or deleted
from the study.

1. Load the study to be edited into the Study Queue pane by clicking the location in the tray
display and then clicking Edit Study.

2. Double -click the experiment node to be edited, or simply drag the node to the trash can
to delete it.

After changing the parameters, click Save.
4. Select the location of the sample from the tray display, and click Submit.

Click Done to return the interface to Review mode.

4.2.6 Extending an existing study

After a study has been created, it is possible to add experiments to the study. Study status
(pending, active, completed) does not affect adding experiments to the study. The Study does not
have to have been collected on an instrument. Studies can be continued on any VnmrJ 3
spectrometer. After a Study is loaded and ready for edit, the workflow is identical to the creation
of a new Study.

1. Load the study to be edited into the Study Queue pane.\
a. Select the location in the Tray display.
b. Select a data set from the study.
File>Open->select the file or FID to open->Go to Main menu->Tools—> Study Queue
Actions>Refresh Study Queue.
For more information, see File Menu and See Tools Menu.

c. By recalling a previous Automation file using the Tray Archives tool (see Automation
Menu) and clicking the appropriate location in the tray display.

2. After the study is loaded into the Study Queue, click Continue Study or
Edit Study (for active/pending Studies).

3. Add experiments to the queue from the Experiment Selector and customize, see Editing
experiments in a pending study.

4. Select the location of the sample in the tray display and click Submit.

Click Done to return the interface to Review mode.

4.2.7 Deleting a Sample From the Queue

To delete a sample from the Study Queue:
1. Select New Study.
2. Select the location to be deleted from the tray display.
3. Select Edit Study from Location.
4. Select Clear Pending Exp from Queue.
5. Select Submit.
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4.3 Operations Without a Robot Sample Changer
Study Quewe

View: Sample LI

MNew Study ‘ Continue Study

Figure 6 Study Queue—Review Mode

4.3.1 Study Queue Controls—Review Mode

When in Review mode the Study Queue pane is used to display information about the current
study.
The View pull-down selects what information is displayed:

e Sample — shows the study linked to the data in the current workspace

e Active Sample — shows the study that is currently running

The New Study button initializes a new study and moves the software to Submit mode. The
Continue Study button modifies a completed study currently displayed in the Study Queue.
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4.3.2 Study Queue Controls—Submit Mode

In Submit mode, the Study Queue pane is used to build a study and submit it to acquisition.

Button

Function

Done button

Abandons any changes made to the current study and
returns the software to Review Mode.

New Study button

Creates a new study.

Submit button

Submits the current study to acquisition. The associated
pull-down menu determines how the acquisition is to be
performed.

Foreground exp

Submits the study to acquisition in the current
workspace.

Background

Submits the study to a background copy of VnmrJ.

Clear Pending Exp from
Queue button

Deletes all pending experiments from the current Study
Queue.
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4.3.3

Using the Study Queue—Full Automation

To collect a series of spectra on a sample using the Study Queue:

1.

7.
8.

4.3.4

Place the sample in a spinner turbine and adjust its position using the sample depth
gauge. Insert the sample/spinner into the magnet. For more information, see 3.2.2 To
Insert a Sample, Without a Sample Changer.

Click New Study in the Study Queue vertical panel. This initializes the Study and moves
the software into “submit mode.”

Click on the buttons in the Experiment Selector to add the desired experiments to the
Study Queue. The order of the experiments in the Study Queue can be changed using a
click-and-drag action. Dragging an experiment node to the trash can deletes it from the
queue.

Experimental parameters for an individual experiment can be customized by double-
clicking on the experiment node in the study queue. (This is dependent upon the rights
and privileges permitted for each user by the System Administrator.) The parameter set
is loaded into the current workspace where any desired changes can be made using the
horizontal panels under the “Acquisition” tab. Once the desired changes are complete,
click Save.

Fill in the information associated with the sample, such as sample name, solvent, email
address, comments about the sample, etc. The sample name parameter is typically
required as part of the automatic data saving routine, and the solvent information is used
to set the spectral window.

Select the checkboxes to control automatic printing, locking, shimming, and tuning, as
appropriate.

Click Submit.

The software will submit the Study Queue to acquisition and return to Review mode.

Creating a Study Queue from data acquired manually

A common workflow in the research laboratory is to collect multiple proton spectra on a sample
as the user optimizes conditions, such as shimming or solvent suppression, for that sample.
Once the experimental conditions are deemed correct, a series of spectra can be acquired. The
Study Queue supports this common workflow.

1.

Acquire a PROTON spectrum (any experiment could be used but PROTON is most
common) in foreground using manual acquisition. (See Chapter 1, Spectroscopy User
Guide).

Use the File > Autosave function to save the fid using the data save template
established in User Preferences (See Templates Tab). This action creates the directory
structure required by the Study Queue.

In the Study Queue pane, select View - Sample to refresh the Study Queue display.
Click Continue Study to open the Study and move the software into “submit mode.”

Click on the buttons in the Experiment Selector to add the desired experiments to the
Study Queue. The experiments are created based on the optimizations done in the
PROTON experiment, retaining optimized parameters such as sweep width, solvent
suppression, and so on.

Once the Study has been built and customized as desired, click Submit.
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4.3.5 Editing experiments in an active study

Until acquisition has begun on a queued experiment, that experiment can be modified or deleted
from the active study.

1. Load the active study into the Study Queue pane by choosing View - Sample.
2. Click Edit Study.

3. Double - click the experiment node to be edited, or simply drag the node to the trash can
to delete it.

4. After changing the parameters as desired, click Save.
Click Submit.

4.3.6 Extending a completed study

Once a Study has been created, it is possible to add more experiments to that Study whether the
study is active or completed. The Study does not have to have been collected on any particular
instrument. Studies can be continued at any time on any spectrometer under VnmrJ 3. Once the
The workflow is identical to the creation of a new study once the study to be edited is loaded.

1. Load the study to be edited into the Study Queue pane

a. by choosing View - Sample in the Study Queue pane when the current workspace
holds a data set from the study of interest.

b. by recalling a data set from the study of interest using File > Open (see File Menu)
and then selecting Tools > Study Queue Actions > Refresh Study Queue. (See
Tools Menu)

2. Once the desired Study has been loaded into the Study Queue, click Continue Study.

3. Experiments can now be added to the queue from the Experiment Selector and
customized as described above.

4. Click Submit.
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Chapter 5 Reprocessing Data

5.1

This chapter describes how to retrieve the dataset, Fourier Transform (FT) the dataset, alter the
dataset parameters, use the graphical toolbar, display parameters, and save.

Sections in this chapter include:

5.1 Retrieve the dataset from the disk

5.2 Fourier Transform the Dataset

5.3 Alter Processing Parameters

5.4 Interact with the spectrum using the graphical toolbar
5.5 Display parameters

5.6 Save Current Process / Display parameters

Retrieve the dataset from the disk

5.1.1 Using the Open window

Before any re-processing can be done on a dataset, the desired dataset must be in the current
workspace. (To change to a different workspace/experiment/viewport, see the Spectroscopy
Guide.) Browser and Locator can also be used to retrieve data, see 5.1.2 and

To retrieve the data: File>Open.

The resulting pop-up window lets you access the desired data directory.
1. Select the desired file.

2. Click the Open button.

The selected dataset is loaded into the current workspace.

= Open
Choose Home Directory: /home/vnmrl/vnmrsys /data |v
Dir 1 | Dir 2 | Dir 3 | Dir 4 |
ook [t -] @2l=]EE
auto_2007.05.23 [ Cosy_01.fid [ Gdgeosy_0O1.fid CiHmbe_
Clheart.dat [ dept.fid [ Chmbe_01 fid [ Hmge_
S monkey.dat [ Depr_o1.fid [ Ghmbead_01.fid [ Hmgeta
[ studydemo ] Dgcosy_01.fid O Chmge_O1.fid k] Hsqec 0
[ Apt_0L fid [ fid 1d.fid [ chmgetoxy_01.fid [ Hsqead
[Yc13.4Tfid [ fid2d fid [ Ghsge_01.fid [ Hsgeto
[ carbon_01.fid [ fid2da.fid [ Ghsqgcad_01.fid [image.4
[ Cigar2j3j_01.fid [ Geosy_01.fid [ Chsqgetoxy_01.fid 1 menth
4] i ] [»
File Name:  |/vnmr/fidlib |
Files of Type: |All Files |
Open || Cancel |
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5.1.2 Using the Locator and Browser windows

The Locator provides access to data sets and experiments.

ocalo (=)=
p Show All My Workspacas

al filename = | segil = | exp ¥
awpl info 1
Qs info 2
exp3 info 3
e fod info 4

Figure 7 VJ Locator popup menu

1. Click Tools from the main menu.
2. Click Locator...

Click the magnifying glass icon to open a menu of searches. Selecting a search changes the
search sentence (next to the magnifying glass icon). The results of the search are displayed in
the list. Those items in the white part of the list satisfy the search sentence. Those in the gray part
do not. Three attributes are displayed for each item that is found by the search. The attributes
correspond to the three columns in the list. Click the attribute name at the top of the list opens a
menu of attribute choices.

Click an item in the Locator list to select that item. The selected item can be dragged to the
graphic area or the parameter panel area to cause the appropriate action.

For example, dragging a data set to the graphic canvas retrieves that data set into the current
workspace (experiment). Dragging a workspace to the graphic canvas causes that workspace
(experiment) to be joined with the graphic area. Double-clicking an item performs the same action
as dragging the item to the graphics canvas.
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5.2

V] Browser

Choose Home Directory: fhome fvnmrlfvnmrsysfdata ‘v

Dir 1 | Dir 2 | Dir 2 | Dir 4 |

Look In: ‘deata |" @@@‘
File Marna: H

Files of Type: “fid iV|

Browser Buttons

Icon | Icon Description

Go up one level in the directory tree.

Gl

Go to user’'s home directory.
= y
5 Make a new folder in the current directory.

Show list of files and directories at the current directory level.

" o— 1| | Show details of files and directories at the current directory level.
O—

5.1.3 Using the Study Queue

If a dataset was run in VnmrJ 3 or later, all related data in the corresponding study can be
brought into the Study Queue window by clicking on the Refresh Study Queue button in
Tools>Study Queue Actions. This facilitates the review or re-processing of the other datasets in
that study.

Fourier Transform the Dataset

5.2.1 Fourier Transform of One-Dimensional Data

The data is typically Fourier transformed into a spectrum before analysis. The data is stored as
time-domain data; the FT converts it to frequency-domain data. FT can be done using any of the
following buttons/ menu:

e The blue-green Transform button in the Action Bar

e The Transform All button on the upper left of the Process / Default page (it is also on the
Process/Weighting page)
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5.3

e The Process button in the middle bottom of the Process / Basic page
e The Process menu, which has options for either Process or Display 1D and Full Process

5.2.2 Fourier Transform of Two-Dimensional Data

The FT of a 2D dataset can also be done in several equivalent ways:
e The blue-green Transform button in the Action Bar

o The Full 2D Transform button on the upper left of the Process / Default page (it is also on
the Process/Weighting page and the Process/More 2D page)

e The Process button in the middle bottom of the Process / Basic page
e The Process menu, which has options for Full Process 2D

e The full processing of a 2D spectrum requires a Fourier Transform along two
perpendicular directions, called t1 and t2. These two processing steps can be done one
at a time if desired. This allows you to customize the processing parameters in each
direction (if desired). For more details, see the corresponding Spectroscopy Guide.

Alter Processing Parameters

More information can be extracted from an NMR spectrum if the processing parameters are
optimized specifically for that spectrum (optimized in ways which help answer the questions being
asked). Examples include changing the parameters that control processes like zero-filling,
weighting functions (and apodizations), linear prediction, referencing, or integral reset points.
These parameters are typically controlled using the Process tab.

5.3.1 Zero-Filling

Zero-filling is controlled by the Transform Size controls, which are located on multiple pages,
such as Basic, Default, Weighting, and More 1D pages. If the number of points used is larger
than the number of points acquired, zero filling is being performed. This helps to better define
shapes of the peaks. It is common and advantageous to transform twice as many points as were
acquired. The user can transform fewer acquired data points, which allow the FT calculation to be
faster, but at the expense of a less well-defined lineshape.

5.3.2 Weighting and Apodization

The detailed parameters controlling the weighting functions and functions that are applicable to
the FID before the FT, are defined in the Weighting page in the Process tab. There is also a
simplified set of controls on the Default page. Typically, weighting functions are used to increase
signal-to-noise, at the expense of broader lines. These functions are used to remove truncation
wiggles from the spectrum as needed. The “apodization” process is when the weighting functions
are used to remove truncation wiggles

5.3.3 Linear Prediction

All of the detailed parameters that control linear prediction are located in the More 1D page.
There is a simplified set of controls on the Default page. The Auto buttons set up a default set of
conditions for either forward or backward linear prediction. Many of the protocols in the
Experiment Selector set up appropriate parameters for using linear prediction automatically. For
more detailed information about controlling linear prediction, see the Spectroscopy Guide.
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5.4

5.3.4 Referencing

Automatic processing uses a routine to provide default referencing for the spectrum. To alter the
referencing, use the controls located in either the Default or the Display pages. Referencing By
Solvent or By TMS automatically analyzes the spectrum. Referencing the spectrum to a certain
cursor position requires the user to place the cursor at the desired location in the spectrum and
type in the desired numerical value for that position in the Reference cursor to entry box.

5.3.5 Integration

Integral regions are automatically set up for Proton spectra during automated processing. Further
manipulations of the integral can be made by using the controls in the Integration page on the
Process tab, or in the graphical tool bar, see Interact with the spectrum using the graphical
toolbar.

5.3.6 Phasing

Proper spectral phasing is automatically set up for all spectra during automated processing.
Further manipulations of the phasing can be made using the graphical toolbar.

Interact with the spectrum using the graphical toolbar

The graphics control bar for the active viewport is to the right of the graphics canvas. Use the
buttons in the bar to control the interactive display in the graphics canvas.

5.4.1 Common Graphics Display Toolbar Controls

The following tools are common to 1D, nD, and FID display toolbars.

Table 5 Graphic Display Tool Bar Controls

Icon Description

ﬂ Reset to full display.
4&| Zoom in.

% Zoom out.

@ Select zoom region.
EI Redraw display.

@| Return to previous tool menu.
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5.4.2 1D Display Spectrum Toolbar Controls

Icon Description

One cursor in use, click to toggle to two cursors.

Two cursors in use, click to toggle to one cursor.

= =

Click to expand to full spectral display.

i.

Pan or move spectral region.

Display integral.

IS |

Display scale.

3
[ .

Toggle threshold on or off.

Phase spectrum.

E |

5.4.3 Integration and Graphics Controls

This section describes methods and tools for displaying, and plotting integrals.

Cursor or box J.I
l‘l_,_! Expand or full display wW

Click icon to access
next tool bar

Grab and move

Set integrals Hide Integral

Define integral regions Delete integral regions

Integral LvI/Tlt

.

Integral Lvl/TH

Return to <+:Letu o ﬂ H :
Ret t
A" i

48



5.4.4 nD Display Toolbar Controls

Icon

Description

Al

Display color map and show common nD graphics tool.

Q

Display contour map and show common nD graphics tool.

‘.i

ks

Display stacked spectra and show common nD graphics tool.

[]‘

Display image map and show common nD graphics tool.

One cursor in use, click to toggle to two cursors.

H
m

Two cursors in use, click to toggle to one cursor.

Click to expand to full display.

<
_'___‘1

Pan and stretch.

Show trace.

Show projections.

Shows horizontal maximum projection across the top of the 2D display.

Shows horizontal sum projection across the top of the 2D display.

Shows vertical maximum projection across the top of the 2D display.

Shows vertical sum projection down the left side of the 2D display.

Rotate axes.

B ¥ & E

Increase vertical scale 20%.
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5.5

Description

Decrease vertical scale 20%.

Phase spectrum tool bar selection.

First spectrum selection.

Second spectrum selection.

Enter peak pick menu.

DEOE @ F

Display parameters

The parameters that control the appearance of the spectrum can be saved in temporary display
parameters files, which allow the user to easily jump between different displays of one dataset.
There are eight display-parameter files available for each experiment (workspace) in each user
account. Each display-parameter file saves the parameters that describe the appearance of the
spectrum like sp, wp, sp2, wp2, sc, wec, sp2, wc2, vs, is, vs2d, th, andthe
integral reset regions). This file does not store or alter phasing, referencing, or baseline-
correction information.) The files are created with the typed command s1, s2, s3, uptosS8,
and recalled with the typed commands r1, r2, r3, upto r8. The typed commands frl
through £r8 (“full recall 1") also recall the integral reset regions, which are not recalled with the
simpler r1 style command.

These display-parameter files can be copied to other experiments by using the typed command
md (m,n) (where m is the experiment with the files and n is the experiment to which you want to
copy the files). This copy function can also be accomplished by using the Edit / Move Display
parameters menu. This capability is quite useful for looking at exactly the same expansion of
multiple NOESYs run with different mixing times, or looking at exactly the same expansion region
in multiple NOESY, TOCSY, ROESY, and COSY datasets.

The display-parameter files remain in the local experiment until the experiment is either deleted or
the files removed. The display-parameter files are not useful for experiments run with different
spectral widths; for example, if an s1 was saved on a proton spectrum, if a carbon spectrum is
later brought into this same experiment, the r1 will give a non-useful expansion.
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5.6

Save Current Process / Display parameters

In the Basic and Default pages of the Process tab, there is a button labeled Save Current
Process / Display Parameters. Click this button to save a parameter set in the dataset with all the
current processing and display information, in a manner that is suitable for GLP requirements.
This action stores parameters such as phasing, integral regions (resets points and isadj), and
the display information that would be stored by the s1 and r1 commands (described above). (It
does not store information about referencing, symmetrization, baseline correction, or drift
correction.) The next time any Process button is clicked, the last-stored set of display parameters
will be used to display the resulting spectrum.

For more detailed information about processing NMR data, see the corresponding Spectroscopy
Guide, Chapter 6 (for 1D data) and Chapter 11 (for 2D data), where each of the steps discussed
above is covered in more detail.
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Chapter 6 Interpreting Data

This chapter includes:

6.1 Viewport Tab

6.2 Working with Viewports and Inset Frames

6.3 Requirements for Aligning and Stacking Spectra
6.4 Setting up Stacked Aligned Spectra

6.5 Interactive Zero- and First-Order Baseline Correction Mode
6.6 Displaying Integrals Step-by-Step

6.7 Baseline Correction

6.8 Baseline Correction Commands

6.9 Integral Reset Points Commands

6.10 Integral Regions Commands

6.11 Integral Display and Plotting Commands

6.1 Viewport Tab

Click the Viewport tab to display the viewport controls. If not visible, click View on the main menu
and select Viewport. Refer to Viewport Tab, for description of the tools and buttons.

Number of Viewports
10203 =4 50607 B9
Viewports
Select Workspace Label Hide Active
vil |2 2EI_PROTON_01 1
V2 o8 ZEI_gHMBC 01 2 =
3 s VPAK174_100119102( 3
a4 [roa El CA 1
Viewport layout
Auto Overlay Viewports
v Sync Cursor | Show crosshair
v Sync Axis | Show fields
Color by viewport v| Show axis
Contours
Viewport 2
Contour levels: 16
Spacing factor 13
v/ Positive contour
v, Negative contour
[v] Multi color contours AutoScale

Figure 8 Viewport Tab
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6.1.1 Viewport Tab
Field Function

Viewports Select the number of viewports to display.

Select the layout for the viewport and cursor, axis , and othe

Viewport Layout viewport controls.

The contour panel displays if the active viewports contain an
Contour Nd spectrum. More extensive controls provided on the 2D
vertical panel.

6.1.2 Inset Frame Buttons

Use Inset Frame buttons to delete one or all inset frames and to restore the default frame to full
size.

Button Function

Delete Inset | Delete the selected inset.

Delete all Delete all inset frames.

Full size Restore the default frame to its full size.

6.1.3 Display Check Boxes

Display Check boxes controls optional display features.

Check box Function

Cross hair Display cross hair and chemical shift(s) of the cursor position when
mouse is moved over the spectrum.

A useful function when the fields are not shown, not in cursor mode
(default mode), or when chemical shift of a peak without moving the
left cursor is required while in the cursor mode.

Fields Display cr, delta, vp etc.fields at the bottom of the viewport.

AXxis Show scale of the axis.

Show frame | Select the check box to display a box around the frame.

border Clear this check box to display the four corners of the selected frame
as hot spots for resizing.

No border or corner will be displayed if a frame is not selected. An
empty frame is not visible until it is selected.

Working with Viewports and Inset Frames
All VnmrJ graphics are displayed in frames. The viewport has a default frame that occupies the

entire viewport graphics area. An inset frame initially shares the same workspace and data as the
original frame and is configured in the same way as the default frame.
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6.2.1 Creating an Inset Frame

An inset frame has the full capability of the default frame. The only difference is that the default
always exists, while an inset frame can be created and removed.

Figure 9 Creating an Inset Frame

Create an inset frame within the default viewport frame as follows:

1. Select the inset mode tool

2. Place the cursor at the low field (left) side of the region to be expanded as shown in Figure 9,
frame la.

3. Hold the left mouse button down and drag the inset window to the high field (right) side of the
region.

4. Drag the cursor down to set the height of the inset frame as shown in Figure 9, frame 1b.

5. Release the mouse button to create the inset frame, see Figure 9, frame 2.

6.2.2 Zooming in on a Region Within an Inset Frame

S

2. Click inside the frame to make the frame active.

1. Select the default mode tool

3. Aframe has a yellow border when it is active and white border when it is inactive (these are
the default colors of inactive and active frames).

4. Select the zoom mode tool L

Place the cursor at the low field (left) side of the region to be expanded as shown in Figure 4
frame 3a.
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6. Hold the left mouse button down and drag the inset window to the high field (right) side of the
region, Figure 4 frame 3b.

7. The region selected is indicated by a transparent gray rectangle.

8. Release the mouse button and the selected region expands to fill the inset box, Figure 4
frame 4.

6.2.3 Resizing an Inset Frame

S

2. Click inside the frame to make the frame active. An active frame has a yellow border.

1. Select the default mode tool

3. Move the mouse cursor to a corner of the inset frame. The cursor changes from a single-
headed arrow to a double-headed arrow.

4. Hold down the left mouse button and grab the corner of the frame.
Drag the corner to resize the frame.

6. Release the left mouse button when the frame is at the desired size.

6.2.4 Moving an Inset Frame

S

2. Click inside the frame to make the frame active. An active frame has a yellow border.

1. Select the default mode tool

3. Move the mouse cursor to an edge of the inset frame. The cursor changes from a single-
headed arrow to a four-headed arrow.

4. Hold down the left mouse button and grab the edge of the frame.
Drag the frame to the new position.

6. Release the left mouse button when the frame is at the desired position.

6.3 Requirements for Aligning and Stacking Spectra
Spectra can be a mixture of 1D and 2D data sets, all 2D data sets, or all 1 D data sets, provided
the following requirements are met:
e All selected viewports need to use a common scale.

e Data in the viewports may have different nuclei, different spectral widths, or different
spectral regions. The common scale is determined based on data in all selected
viewports and determines whether alignment or stacking is possible. Overlaid and
stacked spectra are drawn based on the common scales.

e Alignment is enabled if more than one axis in more than one viewport has the same axis
(H1, C13 etc).

e Stacking is enabled when data in all viewports have the same axis/axes.

6.4 Setting up Stacked Aligned Spectra

1. Select the Viewport tab from the vertical tabs panel.

2. Load each data set into a different viewport and process the data. Data must meet the
Requirements for Aligning and Stacking Spectra.
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3. Select viewports containing spectra to overlay by selecting the check box under Select.

4. Click Overlay viewports button to overlay all selected viewports.

The Stack Spectrum button, Figure 10, is displayed below Overlay Viewports button, if all
spectra have the same dimension (all 1D or all 2D) and all axis/axes (nuclei) match.
Stacked spectra are aligned and each spectrum is shifted along x and y. The shift
between spectra is specified by x and y offset in the entry fields below Stack Spectrum
button. Spectral axes are also synchronized to enable zoom and pan of the spectrum
without losing the alignment.
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- e . - -.u_m“m e 1= 8
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Figure 10 1D Stacked Spectra

The Align spectra button, Figure 11, is available when multiple spectra are overlaid - a mix of 1D
and 2D spectra. All 2D spectra must have matching axes. All 1D data must match one of the 2D
axes. 1D spectrum is aligned and displayed at the margins of the 2D spectrum. 1D spectrum is
rotated if necessary to align with the 2D spectrum. Zoom and pan tools are synchronized when
the spectra are aligned.
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Figure 11 2D Spectra with Overlaid 1D’s

The stacked spectrum button for 2D spectra, Figure 12, is displayed below Overlay Viewport if all
2D spectra axes and nuclei match. Spectral axes are synchronized to enable zoom and pan of
the spectra without losing alignment.
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Figure 12 Stacked Overlaid 2D Spectra
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6.5 Integration and Level and Tilt

Methods, and tools for displaying and plotting integrals are described below.
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6.5.1 Interactive Zero- and First-Order Baseline Correction Mode

The Integral LvI/TIt button activates interactive zero and first order baseline correction mode. The
zero order correction is represented by the vl parameter; the first order correction is represented
by the tlt parameter. If no integral is displayed when the Integral LvI/TIt button is clicked, the
integral is automatically displayed.

1. Click the left mouse button on an integral region of interest, about halfway vertically up
the screen.

A horizontal cursor intersects at the mouse arrow. Two vertical cursors are placed on
either side of the mouse arrow.

2. Click the left or the right mouse button above or below the horizontal cursor, but within
the two vertical cursors, to adjust the zero-order baseline correction parameter Ivl.

e Clicking above the horizontal cursor increases Ivl.
e Clicking below the horizontal cursor decreases Ivl.
e Clicking on the horizontal cursor restores the initial baseline correction value.
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3. Click the left mouse button on another region of the spectrum, outside the vertical
cursors.

A new horizontal cursor displays at the mouse arrow, two new vertical cursors display on
either side of the mouse arrow, and a single vertical cursor displays in the middle of the
region where Ivl was being updated. The mouse now controls the first-order baseline
correction parameter tlt.

4. Click the left or the right mouse button above or below the horizontal cursor to increase or
decrease tlt, and change vl so that the total drift correction at the single vertical cursor in
the middle of the previous region is held constant.

This process eliminates or substantially reduces the necessity to iteratively adjust the two
parameters Ivl and tlt. As with the zero-order correction, placing the mouse arrow right on
the horizontal cursor and clicking the mouse button will restore the initial baseline
correction values.

Each time the mouse is clicked outside the two vertical cursors, new vertical and
horizontal cursors display.

Using the left and right mouse buttons, you can adjust both adjust the baseline correction
parameters differing only in their sensitivities. The left mouse button causes changes a
factor of eight times larger than the right mouse button making the left button a “coarse”
adjust and the right button a “fine” adjust. The overall sensitivity of these adjustments can
also be controlled by the parameter Ivitlt. The parameter can be set according to the
following:

e The default value is 1.
o Make Ivltlt larger than 1.0, to make larger changes.
e Set Ivitlt to be between 0.0 and 1.0, to have finer control.

The middle mouse button adjusts the integral scale (parameter is) or the integral offset
(parameter io), exactly as whenever an integral is displayed.

5. Exit the interactive baseline correction mode by clicking another graphics control button.

6.5.2 Displaying Integrals Step-by-Step

The following methods provide an opportunity to compare procedures. Before starting each
procedure, be sure to obtain a typical spectrum by entering:

1. Load a data file into the active viewport using the file browser or the Locator.
2. Transform the data, if necessary.

3. Click the Process tab.

4. Select the Integration page.

5

Click any one of the Integration Display Mode option buttons:
e Full: Shows integrals over the entire spectrum, including the noise.
e Partial: Shows even integrals regions and hides all the odd integral regions.
e Off: Turns off the integral display.

6. Click Auto Find Integrals to automatically set the integral resets, and display the data as
set by the Integration Display Mode option button.

7. Click Scale display to fit button to automatically scale the display.
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6.5.3

N o o kM wbdh PR

Set the integral area:
c. Enter avalue in the Integral Area field.

d. Click one of the following option buttons under the Normalize Area to: page region.

e Single Peak — select the region or peak under the cursor as the reference and set
the single peak integral to the value in the Integral Area field when the Set Integral
Value button is clicked.

e Sum — sets the entire integral to the value in the Integral Area field.
Do not click the Set Integral Value button; this button sets the single peak reference.

Display the integral results as follows:

Single Peak — both the Show Integral Values and Show Normalized Value buttons are
active.

Integral Values

Click Show Integral Values to display the values of the integral regions on the
screen below the spectrum.

Click Display Lists of Integrals to list the display regions and the value of the
integral over each region.

Normalized Integral Values

Click Show Normalized Values to display the values of the integral regions
normalized to the reference region on the screen below the spectrum.

Click Display Normalized Integrals to list the display regions and the value of the
integral over each region normalized to the reference region.

Manual Method

Load a data file into the active viewport using the file browser or the Locator.
Transform the data if necessary.

Click the Process tab.

Select the Integration page.

Click Clear Integrals.

Any currently defined integral reset points are cleared.

Set up the integral resets from left to right (down field to up field).
a. Click Interactive Resets button.

b. Place the cursor to the left of the first integral region.

c. Click the left mouse button.

d. Move the cursor to the right of the first integral region.

e. Click the left mouse button.

Repeat Step 7b.

Click Scale display to fit button to automatically scale the display.
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6.6

10. Set the integral area as follows
a. Enter avalue in the Integral Area field.

b. Click one of the following radio buttons under the Normalize Area to: page region.

e Single Peak — select the region or peak under the cursor as the reference and set the
single peak integral to the value in the Integral Area field when the Set Integral Value
button is clicked.

e Sum — sets the entire integral to the value in the Integral Area field.
Do not click the Set Integral Value button; this button sets the single peak reference.

11. Display the integral results as follows:

e Single Peak — both the Show Integral Values and Show Normalized Value buttons are
active.

¢ Integral Values

e Click Show Integral Values to display the values of the integral regions on the screen
below the spectrum.

e Click Display Lists of Integrals to list the display regions and the value of the integral
over each region.

e Normalized Integral Values

e Click Show Normalized Values to display the values of the integral regions normalized
to the reference region on the screen below the spectrum.

e Click Display Normalized Integrals to list the display regions and the value of the
integral over each region normalized to the reference region.

Baseline Correction

Most operations performed on spectra assume a “good” baseline. Line lists, integrations,
resolution measurements, 2D volume integrations, and so on measure intensities from “zero” and
do not perform any baseline adjustments. Perform a baseline correction operation before
performing further data reduction if the baseline in your spectrum is not “good.” Two types of
baseline corrections are provided, linear and non-linear, and are available using the buttons on
the Display page.

6.6.1 Baseline Correction Commands

The dc command turns on a linear baseline correction, using the beginning and end of the
displayed spectrum to define a straight line to be used for baseline correction.

dc calculates a zero-order baseline correction parameter 1v1 and a first-order baseline
correction parameter t1t. The cdc command turns off this correction. The results of the dc or
cdc command is stored in the deg parameter, which can be queried to determine whether drift
correction is active by typing dcg? on the command line. If active, deg=""; if inactive,
dcg='cdc'.

The bc command performs a 1D or 2D baseline correction. The 1D baseline correction uses
spline or second to twentieth order polynomial fitting of predefined baseline regions. bc defines
every other integral, that is, those integrals that disappear in partial integral mode
(intmod="partial ") as baseline and attempts to correct these points to zero. A variety of
parameters can be used to control the effect of the bc command.

For more information about the bc command, refer to the entry for bc in the Command and
Parameter Reference.
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6.7

6.8

6.9

Integral Reset Points Commands

The z command (or the equivalent button or icon) resets the integral to zero at the point marked
by the displayed cursor. z(resetl, reset2, . . .) allows the input of the reset points as part of
a command, instead of using the position of the cursor. Reset points do not have to be entered in
order. The resets are stored as frequencies and will not change if the parameter fn is changed.
The command cz (or the equivalent button) removes all such integral resets.
cz(resetl,reset2, .. .) clears specific integral resets.

The liamp parameter stores the integral amplitudes at the integral resets points, and the lifrg
parameter stores the frequencies of integral reset points, for a list of integrals. To display the
values of liamp, enter display ("liamp®) with a Text Output page selected. Frequencies
are stored in Hz and are not adjusted by the reference parameters r£1 and rfp.

Integral Regions Commands

The region command divides a spectrum into regions containing peaks. A variety of parameters
can be used to control the effect of the region command; see the Command and Parameter
Reference for details.

Integral Display and Plotting Commands

Displaying and plotting the integral trace is independent of the values of the integrals. The height
of the trace is controlled by the parameter and can interactively be adjusted after the spectrum is
displayed with the ds command. Also, the macro isadj(height) (or the equivalent button) adjusts
the integral height so that largest integral fits the paper or is set to a specific height (in mm) if the
“height” argument is provided, for example, isadj(100).

The command dl i (or the equivalent button) displays a list of integral values at the integral reset
points. The frequency units of the reset points are defined by the parameter axis. The reset points
are stored as Hz and are not referenced to rfl and rfp. The amplitudes are stored as actual
values; they are not scaled. The integral values are scaled by the parameters ins and insref
and the Fourier number. Typically, ins is set to the number of nuclei in a given region. For
example, if a region represented a single methyl group, the following procedure would scale the
integral values of that region:

1. Setins=3.
2. Set insref to the Fourier-number-scaled-values of that integral.

3. Enter dli. The integral value of that region is displayed as 3 and all other integral values are
accordingly scaled.

Integral value scaling can be interactively set with the ds command. The Setint macro can also

be used to adjust integral value scaling. Setint sets the value of an integral and is used in
conjunction with the command dl i to scale integral values. Normalized integral values can also
be selected. In this case, ins represents the total number of nuclei. The individual integral values
will be scaled so that their sum is equal to ins. The normalized mode may be selected by setting
insref to “not used.” The integral is scaled by ins and insref.

Two commands are closely related to dI'i:
o nli isequivalentto dIi except that no screen display is produced.

e dIni normalizes the values from dli using the integral normalization scale parameter
ins and then displays the list.
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The dpir command displays numerical integral values below the appropriate spectral regions,
using the integral blanking mode in which only every other integral is plotted. The command
dpirn shows the normalized integral values in an analogous fashion.

The pir command plots digital integral values below the spectrum, using the integral blanking
mode in which only every other integral is plotted. The command pi rn plots the normalized
integral values in an analogous fashion.

6.9.1 Using Viewports Region Controls

The viewport controls are present if there are two or more view ports.
Showing and Hiding Viewports

The selected viewports are arranged on the graphics canvas based the layout selection. See
Setting Viewport Layout.

1. Select the check box next to each viewport to show on the graphics canvas.
2. Clear the check box next to a view port to hide the viewport.

3. Point the cursor to the box next to the viewport label and hold down the left mouse button
to temporarily hide a viewport.

4. Release the mouse button to show the viewport.

The viewports do not change their layout on the graphics screen. This tool is used when
overlay viewports is selected.

Making a Viewport Active
1. Click the radio button associated with a viewport to make the viewport active.
The title bar of the active viewport is colored. The inactive viewports have gray title bars.

2. Use the horizontal and vertical panel tools to work on the data in active viewport or begin
data acquisition using the active panel.

Experiments started from the current active panel are run in the order of submission.
Systems running an automated sample changer use only experiment 1 (which is in
viewport 1) to submit samples to the automation queue. All other viewports are used for
data processing and analysis.

Adding a Label to the Viewport

The default label for a viewport is the currently loaded experiment’s file name.
1. Click inside a viewport's label box (viewport does not have to be active).
2. Select the contents of the box and overwrite the text with new text.

3. Click outside the text box.
A new label is now associated with this viewport.

6.9.2 Setting Viewport Layout

Select a layout icon to arrange the view ports on the graphics canvas. Click the Overlay
Viewports to stack viewport on view port. The overlay is useful for placing high resolution 1D
spectra on the appropriate 2D axes.
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Icon

Function

Auto

Auto layout arranges viewports in an optimized row by
column matrix

E

Horizontal layout of viewports

(I

Vertical layout of viewports

6.9.3 Synchronizing Cursors and Axes

Check Box

Function

Sync cursor

Select this checkbox to link and synchronize the
cursors and cross hairs in multiple viewports.

Sync Axis

Select this checkbox to link and synchronize axes in
multiple viewports. Axis is synchronized to the current
active viewport.

6.9.4 Setting Crosshair, Fields, and Axis Display Options

Check Box

Function

Show crosshair

Select this check box to show crosshairs and display current position.

Show fields Select this check box to show information fields at the bottom of the
active viewport canvas:
Vs spippm} wpppm) first last step
111.7 35.75 £5.00 1 4 1
Show axis Select this check box to show the axis or remove the check to hide the

axis.
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6.9.5 Assigning Colors to Spectra by Viewport

Check Box | Function

Color by Select this check box to display the ]
viewport spectral data using colors assigned e e
by the viewport, see Figure 13. b :.. b

. Dropdown_L— S
Default color assignment: Spectra | color pallet
are displayed using a different color :
1

for each viewport if the box is N G — —
checked. The spectra a displayed Activate B
using the defaults assigned in the colors by a

checking ol
this Doy —= s kvt

Display options window if this box is
not checked.

Change a color assignment: Click Figure 13 Setting Spectra Colors
on the dropdown color menu for a by Viewport

viewport and select a color for the
spectral display in the viewport.

Display Check Boxes

The check boxes control of optional display features.

Check box Function

Cross hair Display cross hair and chemical shift(s) of the cursor position when
mouse is moved over the spectrum. A useful function when the fields
are not shown, not in cursor mode (default mode), or chemical shift of
a peak without moving the left cursor is require while in the cursor

mode.
Fields Display cr, delta, vp etc... fields at the bottom of the viewport.
Axis Show scale of the axis.

Show frame border Select this check box to display a box around the frame.

Un-check the box to display the four corners of the selected frame as
hot spots for resizing. No border or corner will be displayed for if a
frame is not selected. An empty frame is not visible until it is selected.

6.9.6 Contour

The contour sub-panel, Figure 14, appears exclusively for the active viewport with 2D data loaded
and displayed in contour mode (dpcon).
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Figure 14 Contour Controls

The Contour panel has the following controls:

Control

Function

Contour levels

Enter a number of contours between 4 and 32 in the text field.

Spacing factor

Enter a number in the text field to specify the spacing between
contours. A number between 1.1 and 2 is recommended.

Positive contour

Select this check box to show positive contours using the default
color red.

Negative contour

Select this check box to show negative contours using the default
color blue.

Color dropdown

Select a color from the menu to use a color other then the default
color.
Each contour has a color dropdown menu.

Multi color Select this option to use the colors defined in Display Option.
contours If you select the Color by Viewport box,options are not displayed,
AutoScale Automatically scale the spectrum by clicking.

6.9.7 Using Viewports as a Spectral Interpretation Tool

The Viewports tool displays and presents data and provides a powerful interface to interpret
spectral data. A collection of NMR data sets acquired on a given sample are typically more
informative when considered together and simultaneously. Information presented in a 1D data
set is often complimentary to that provided by a homonuclear or heteronuclear 2D data set, and
many 2D data sets are closely linked from an interpretational point of view. Viewports provide

powerful options for

interrogating spectral data.

6.9.8 Overlaying Homonuclear Data Sets

When interpreting homonuclear data, concurrently consider COSY or scalar coupling interactions

(i.e., through-bond) with NOESY or dipolar coupling interactions (i.e., through-space).
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For example, Figure 15 shows the graphics window with COSY and NOESY data sets in
Viewports 1 and 2, respectively, collected on the ethylindanone standard sample. The Overlay
and Align Spectra buttons have been used to provide a composite display. By selecting the Show
Crosshair check box, a yellow cursor line, or crosshair, is displayed simultaneously in each
window. The crosshairs are linked, allowing responses from one data set to be immediately
interpreted with respect to the other. This display clearly differentiates those responses observed
in the NOESY spectrum that are derived from long-range relaxation from the vicinal and geminal
responses.
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Figure 15 Overlaid COSY and NOESY spectra of ethylindanone.

COSY responses are shown in green, while the phase-sensitive NOESY data are displayed in
blue and yellow.

6.9.9 Cross Referencing Heteronuclear Data Sets

Many heteronuclear data sets provide complimentary insights into molecular structure. As shown
in Figure 16, a Viewports overlay of HSQC and HMBC data allows visualization of both 1-bond
and long-range coupling in a single, easy- to -interpret arrangement. This type of display is very
valuable when spectra become congested, and allows unambiguous assignment of long-range
responses to 1-bond Jcy spin pairs.

67



F1 E - - .
{pprm

303
404

60—;
?oé
80—;
90_§

10023

110-?

120_5

130-§ - "

1407 o -

150_5

L T I T T T T I T T T T I T T T T I T T T T I T T T T I T T T T I T T T T I T
3 7 & 5 4 3 2 1

F2{(ppm)

Figure 16 Overlaid HSQC and HMBC spectra of ethylindanone

HMBC responses are shown in green, while the phase-sensitive multiplicity-edited HSQC data
are displayed in blue (odd number of protons) and red (even number of protons).
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Chapter 7 Printing, Plotting, and Data Output

Printing and plotting of data are highly individualized activities. Each user has specific ideas about
proper formats, necessary expansions, and so on.

Sections in this chapter:
e 7.1 Printing of the Graphics
e 7.2 Plotting
e 7.3 Color Printing and Plotting
e 7.4 Sending a Plot via emalil
e 7.5 Pasting text into a Text Editor or another Application
e 7.6 Advanced Printing Commands
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Figure 17 Printout Example
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Printing of the Graphics

After processing, the 1D or 2D spectrum is displayed in the graphics canvas so that the scale,
expansion, and threshold can be adjusted.

To print the spectrum:
1. Click File from the Menu.

2. Select Print Screen...
The pop-up in Figure 18 appears.

3. Select the Name of the printer.
4. Select ViewPorts to print the Graphics area.
5. Choose the number of copies to print.
6. Click the Print button.
|! Print Screen x|
[ General | Page Setup [ Appearance |
Print Servica
Mame: |[laserGp - Properties
Status: Accepting jobs
Type:
Infa: [ |Print to file
Frint Area Copies
® Viewp orts Mumber of copies: 15
3 VINMR) Window Lol
Print Previaew Cancel

Figure 18 General tab of the Print Graphics pop-up

NOTE: The VnmrJ interface can be printed by selecting the VNMRJ Window option.

To print a file:
1. Select the Print to file check box.

2. Figure 19 shows the pop-up that appears when the Print to file check box is selected
and the Print button is clicked.
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= Print File Setup

x|

Browse,,,

File MName: [rest |
Faormat POF -

Size: Lettar -

@ Portrat ' landscape

® Color ) Monochrome
Rackagraund: ||.n.rhite |'| |:||
Foreground: |t:u|a|:k: | | I|

1 pixels
1 pixels
90 doisperirch

Screaeq resolLtion is 85 dots perinch

Spect-um Linz Width:
Craphics Line Width:

Image Fesalutior;

Keep cursor lines

[ | Reshape to fit page

Save Freviaw Cancel

Figure 19 The Print File Setup

Item Description

Sync cursor Select this checkbox to link and synchronize the
cursors and cross hairs in multiple viewports.

Sync Axis Select this checkbox to link and synchronize axes in
multiple viewports. Axis is synchronized to the current
active viewport.

File Name Name of the File to be saved.

Browse Brose a folder to set the location of where the file will
be saved.

Format A dropdown menu choices of various outputs.

Size Dropdown menu choices for paper size.
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Item Description
Orientation Select Portrait or Landscape.
Appearance Use to select Color of Monochrome output.

Spectrum Line
Width

Enter a line width in pixels.

Graphics Line
Width

Enter a line width in pixels.

Image Resolution

Enter the desired image resolution in dots per inch
(dpi).

Screen Resolution

Displays the current screen resolution in dots per inch
(dpi).

Keep Cursor Lines

Select to include cursor lines as they appear in the
display.

Reshape graphics

Select to resize graphics to fit paper size.

to fit paper

Save Saves output to File name.

Preview Starts Adobe Acrobat Reader and displays (without
saving) output.

Cancel Closes Print to File pop-up without saving.

The Page Setup and Appearance tabs allow for settings similar to the Print to File setup to be
applied to the printed output. Additionally, entries are available for paper source, margins, and
print quality (Draft, Normal, and High) while finer control of image resolution and preview is
unavailable.
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Figure 20 The Page Setup tab of the Print Screen pop-up

Figure 21 The Appearance Setup tab of the Print Screen pop-up
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7.2 Plotting

Plotting is based around the concept of a plot file. Set up and submit a plot using the selections
on the Plot Parameter page under the Process tab after the spectrum or FID is displayed. ltems
selected on the Plot Parameter page (Figure 22) are added to a temporary plot file, and the Plot
Page button submits the plot file to the plotter. The Clear Plot button removes the plot file. The
Plot Preview button starts Adobe Reader and displays the output of the plot file. Some of the
menu options in Adobe Reader are available for use. The PlotView pop-up also appears during a
preview, which allows the saving of the view to a pdf format file, sending the output to the default
plotter, a file and to one or more e-mail addresses.

o >
Start|Acquire|Process Transfarm ﬂm“““ Display Spectrum | Clear Screen
Basic Automatic Plot Page ‘ Plot Setup Manual Plot FIDs
Default Full - piot spectrum .l Plot FID
Weighting ; = B—

) Auto Plot Preview ‘ B ; Flot FID Array
Display Parameters Flot Spectrum Array | Plot FID Scale
:\::e:eri?ion Send this plot to: Basic (left) hd Plot Spectrum Scale_|
Cursgorstine Lists laserér [b-+\'\¢']32 - j| Plot Parameters - Plat Pulse Sequence |
e to mm: 22 Integrals i
Text Output Ciaraery e Eiciam Plot Text Clear Plot ‘

= G o | Plot Flot List of Integrals
Left Right Peak Frequencies Flot Molecules Flothags ‘
Autoscale = [ Auto Plot Logo
WYSIWTG show +J -] Plot Flotlogggy setlodg Elot frevic ‘
Figure 22 Plot Parameter page for a 1D data set
To Plot: Select: Click:
Pulse sequence Plot Pulse Sequence
FID Plot FID, Plot Page
FID and scale Plot FID, Plot FID Scale, Plot Page
Spectrum Plot Spectrum, Plot Page
Spectrum and Plot Spectrum, Plot Spectrum Scale, Plot Page
scale
Spectrum, scale, Plot Text, Plot Spectrum, Plot Spectrum Scale,
and text Plot Page
Spectrum, scale, | Parameter Plot Spectrum, Plot Spectrum Scale, Plot Page
and parameters | Template option
Spectrum, scale, | Peak Plot Spectrum, Plot Spectrum Scale, Plot Page
and peak Frequencies
frequencies option
Spectrum, scale, Plot Spectrum, Plot Spectrum Scale, Integrals
and integrals Plot, Plot Page
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To Plot:

Select:

Click:

Spectrum, scale,
and integrals,
integral values

Integrals option

Plot Spectrum, Plot Spectrum Scale, Integrals
Plot, Plot Page

Parameters only

Parameter
Template option

Plot Page

Text only

Plot Text, Plot Page

Peak
frequencies only

Peak
Frequencies
option

Plot Page

Integrals only

Integrals option

Integrals Plot, Plot Page

Scaled integral
values only

Integrals option

Integrals Plot, Plot Page

Normalized
integral values
only

Integrals option

Integrals Plot, Plot Page

Molecules only

Plot Molecules, Plot Page

Logo only

Plot Logo, Plot Page

Using default
settings to the
printer

Automatic Plot Page

Using default
settings to
Adobe Reader
for preview

Auto Plot Preview
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File Edit View Document Tools Window Help X

B i ecvD ©0 TN | H [
T -

Figure 23 Preview of the plot file initiated from pressing the Plot Preview button

Plotname: [PlotView] pdf

Send to: || plotter
] File

[ ] e-address |

Plot [ Save | Email

Edit... Unda Close Abandon

Figure 24 The PlotView pop-up
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The Basic Parameter page (Figure 25) contains a Plot and a Plot Preview buttons; both have the
same function as the Automatic Plot Page and Auto Plot Preview buttons found on the Plot
Parameter page.

sﬂjj%@@q ) RARNA 1 I a e el
e

; i

I
i T T T T T | T B | T
3 7 6 s 4 3 z 1 0 ppm
|
I
Start|Acquirs ‘ Process‘ ‘ Tranifum Display Spectrum | Clear Screen
Sample: ethylindanone Process Options Plot Options
Solvent: cdcl3 FT datasize: 32k ~ ||| Parameters:  Basic >
sample owner: LineBroaden (0.0 Hz Integrals: off hd
Comments: Peak Values On Peaks -

ethylindanone standard sample

Cursors/Line Lists
Plot

ext Qutput
Plot
‘ Display Spectrum ‘ Process Plot Preview

Save Current Process/Display parameters |

Temp | Spin

Lopk [samwle | peobe | 1 T O|C
0.2 CN_2009.5_29 oo

Figure 25 The Basic Parameter Page for a 1D data set

The 1D Vertical Parameter page contains three buttons to direct the output plot, to a Printer (Auto
Plot Page), to Adobe Reader for previewing (Auto Plot Preview), and to call up the Print Screen
window, which is identical in function as selecting File from the menu and then selecting Print
Screen...
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Eile Edit View Experiments Acquisition Automation Process Tools Help

IS0
_ee

Cryo Tune ArrayedSpecira

Protocols r/Frimz rvizwpnn ip m
o

rBasic Process

Transform all Phase Zero Order
Transform FID # |1

Weighting
exponential ;I Interactive J
[v] Transform Size 2k -

Acquired Points 10,242

More Processing - Parameter Pages J

rBasic Display
Vertical Scale
Autoscale J ArrayedSpectra Panel J
+ E
Reference AXis Display Mode
By Solvent ® Hertz (® phased
By TMS CrPPM (0 ahs value
Cancel (0 kHz ) pawer

Wore Display - Farameter Pages

-

rBasic Plotting———
Auto Plot PageJ Auto Plot PrEvie\nd

Print Screen...

More Plotting - Parameter Pages J

! Vnmr]

|3UE 4 JBIEWEEY

delta

I
ppm

Temp | Spin

64.9 Smm_HF _autox; J I

Figure 26 The 1D Vertical Parameter page for a 1D data set

7.3 Color Printing and Plotting

Printer and Plotter color output is defined using the Styles and Themes window, which provides

access to the display colors and the VnmrJ interface colors.

7.3.1 Setting Colors

1. View the current settings or define new color settings as follows:

2. Click Edit.

3. Select Display options...
The Style and Themes window opens, Figure 27.
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]

Color @ Hes |

Styles and Themes

RGE Theme (e fauir | =]
|

jL DispiaCalors I.!u:m" i
FIEVLE  GraphColors

Save

Display and Plotter Qutput
selection menu > Spectra - .

Spectrum L Background whie |- |:|.
FID i Border qray |- o
Imaginary A - Hatspar Eiug '- ..
Scale j0.0.0 -m Hightlight  red - m
Integral i Crosshar  ghocolate 'v ..
Paramuter . Shade archid =m]
Cursor i Images _
Threshold 5] Foreground Em:e

Background [black

Close |

| Edir Abandon || HElp
1! Styles and Themes X
Color ® Hex () RCE Thema |defauit |wll  Save Load [ |

Type of 2D data
_________ Chaose Color GraphCelors Review —]
Peak Color
1 -1 [153.153.255 |~ Paak rea
? 2 2 [51.153.255 |= @| Mumber Diue
3 -3 [s1152.2%5 |~ m| AVBox 153,00
M * -4 [sosizss |~ m| PHBox  ble
& 5 5151255 |v m| Llzbel  darkGrean
: 6 -6 [naw - 0
Pervien !
B m srte T Sarpls Tast ; W S
O e
o Canze Begat
Choose Color window opens r 'T'” . —

when a color button is clicked.

© N o g &

10.
11.
12.
13.
14.
15.
16.

17.

Figure 27 Styles and Themes for Display and 2D Colors

Select Display tab to set the colors for the spectra, axis, parameters, etc.

Click Display and Output selection drop down menu.

Select the output device: Display, Plot Postscript, Plot PCL, or Plot HPGL.
Select a color or keep the current color for each display or function shown.

Enter a name in the field next to the Save button to save the selection to a user defined
file or continue with the next step to overwrite the current file.

Click Save to save the color selections to the specified file.

Click 2D colors.

Click Phase to set the colors for this 2D display mode.

Select the output device: Display, Plot Postscript, Plot PCL, or Plot HPGL.
Select a color or keep the current color for each contour level.

Click Absolute to set the color for this 2D display mode.

Select a color or keep the current color for each contour level.

Enter a name in the field next to the Save button to save the selection to a user defined
file or continue with the next step to overwrite the current file.

Click Save to save the color selections to the specified file.
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7.4

7.3.2

Loading a Color File

To retrieve a color file:

1.
2.

7.3.3

Select a theme file from the Theme drop-down menu.
Click Load.

Changing or Renaming a Color File

To change the colors in a file:

1.
2.
3.
4,

Select a theme file from the Theme drop-down menu.
Click Load.
Follow procedure in Setting Colors 7.3.1.

Click Save to save the file.

To change the name of a color file:

1.
2.
3.
4,

Select a theme file from the Theme drop-down menu.
Click Load.
Enter a new name in the field next to the Save button.

Click Save to save the file.

Optional: To delete the file with the old name, 7.3.4.Removing a Color File.

7.3.4

Removing a Color File

To remove a color file from the list:

1.

WD

Select a theme file from the Theme drop-down menu.
Click Load.
Click Delete. The deleted file is removed from the bottom list box.

Click OK, when prompted, to delete the file, or Cancel to keep the file.

Closing the Color Selection Window

Click Close to exit the window.

Sending a Plot via email

After selecting the options to and clicking the Plot Preview button in the Plot Parameter page.

1.
2.
3.

4
5.
6

Enter a Plot name in the PlotView pop-up.

Check File.

Check e-address.

Enter valid email addresses in the entry field of e-address.
Press the Plot / Save / Email button.

Press the Close button when done.
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7.5

7.6

Pasting text into a Text Editor or another Application

Text output which appears in the Integration, Cursors / Line Lists / Text Output Parameter pages
can be pasted into a text editor or other application as shown in Figure 28, to be saved or used
elsewhere.

1. Highlight the text to be pasted by clicking the left mouse button and dragging the mouse
to the end of the desired text.

Release the mouse button at the end of the desired text. The selected text is highlighted
indicating what has been selected.

2. Start the text editor or application and place the mouse cursor on the active document.

3. Click the middle mouse button to paste the highlighted text into the text editor.

File Edit Miew Experiments Acquisition Autemation Process Tools Help
AHSE00 Lo Wil | Frowno |
w_
g i
a “Unsaved Document 1 - gedit
2 Ble Edit Mew Search Jools Documents Help
a Be.Q & 9 D B @
- New  Cpen Save | Print Unda Paste | Find Replace
& 3 *unsaved Document 1 ®
i hndex freqippm) intensity
= 1 1.03626 40. 9667
] z 1.8213 84.8728
E 3 1.00634 37.4915
4 ARAL PSR |
H
- R R S S
4 - — | 12 10 pom
Lnl. Coll INS
sl =
& — = R
& Stars| Aire] Process || Transtorm i dnopeaRsll o'soieyspearum | Clear screen | RN
= [Basie Cursar = Pesk Thrash | Display Line List [ Find Peaks in Arras
,,\: (=) | play | y.
al
d indes  freqlppea) intensity List of 3 Tines in spectrum 1 to 4
1 1.03628 A0.mea7 ine Treguency (Hz)
10211 Be.0720 1 517.96
E 3 1,00638 J7. 4915 2 51048
3 3 503,01
o 1 pectrum  amplitude ¢
2 plor ar Twn Cursoes on Screen : | go:32
A [Text Ourput Show signal 1o naige 3 1 37,49
1
[ »
T | oo | e [ bk A s
250 ¢ _bid Chl_2009.5.28 ~ —

Figure 28 Contents of the Display Line List text box copied into the Linux gedit text editor

Advanced Printing Commands

Printing from within VnmrJ is initiated with the printon command. All output which normally
appears in the text output window is saved and, when the printoff command is issued, sent to
a printer. This output includes the following:

e Parameter listings from dg, dgl, da, etc.
e Line listings from dl 1.
e Integral listings from dli.

e System configuration parameters generated by config(“display”) .
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e Text files using the text command .

e Results of calculations from h2cal, adept, tl, t2, etc.
e Any other information that some program or macro may write to the text window.

This output is saved in a temporary file in /vnmr/tmp. The VhmrJ parameter printer determines the
printer to which the output is directed. When the printoff command is issued, VnmrJ executes a
UNIX script called vnmrprint that sends the temporary file to the printer using standard UNIX
printing utilities. This script is supplied with the name of the temporary file to be printed, the name of
the printer (corresponding to a printcap entry), and the type of printer (corresponding to an entry in
/vnmr/devicetable. If desired, the script vnmrprint affords a place for user customizing.

NOTE: Information in /vnmr/devicetable is used to distinguish PostScript printers.

The macro ptext prints out the text file given as an argument. For example, the command
ptext(/vnmr/psglib/DEPT. ¢' ) prints the text file DEPT.c.

Print jobs for the currently active printer in VnmrJ are hgeld ir] a print queue. The showprintq macro
displays the current print jobs in the print queue. The klllprlnt macro will stop a print job and remove

it from the print queue. Unless the user executing this macro is root (superuser), only that user's print
job is deleted from the print queue.

Table 6. Printer-Associated Commands and Parameters

Commands Parameter

killprint Stop print job and remove from print queue
printoff«“clear®Ifile»

printon Stop sending text to printer & start print operation
ptext (File) Direct text output to printer Print out a text file
showplotter Display currently defined plotters and printers
showprintq Display print jobs in print queue

vnmrprint* Print text files (UNIX)

* vnmrprint

printer {string} Printer device
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Chapter 8 VnmrJ 3 Preferences

The default behavior of VnmrJ at the user account level has several customizable options. These
options are different from those that can be accessed by the administrator of VnmrJ. The optimal
operation of these customization options requires a properly setup probe file for the probe in use.

Select the Preferences from the Edit menu on the main VnmrJ window to access the VnmrJ
preferences setup window. Note that some of the options appear only if the Enable Email
Options check box has been selected. Ensure that an email server has been properly configured
at the host computer.

Sections in this chapter include:
e 8.1 Templates Tab
e 8.2 Automation Tab
e 8.3 Queue Tab
e 8.4 eOptions Tab
e 8.5 Data Mirror Tab
e 8.6 SampleTags Tab
e 8.7 UserPrefs Tab
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8.1 Templates Tab

Any VnmrJ parameter in the Templates tab can be used to select where the data is saved and

how data is to be named.
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Preferences

Email disabled [ | Enable Email Options

Templates | Automation | Queue E,Opt'luns DataMirror | SampleTags | UserPrefs
( [ i [ [ [ os | |

Template Preferences: Restore to d,afaultw

Stuchy Directory Template (svfdir); [$userdird/data
Sample Directory Template (sampdirtmplt): ($samplenamef _%DATE%:_
Data Template (sviname); [$samplenamed _$pslabelf_
Automation Directory Template (autodir): [auto_2%DATER

Bitmap image format: pdf j| Time display format: [ 12Haur (AM /PM) ;I

Examples:
Stucly Directory:  /home/fvnmrl/smmrsys/data
Sample Directony: Yitamine_D3_20100120_01
Data; Vitamine_D3_HSQC_01 fid
Automation Directony, auto_20100120_01

Save J

‘ Edit... H Undo H Close || Abandon |

Figure 29 Template Tab— Preferences

The following describes the five entries for data saving:

1. Study Directory Template: Defines where the data for all the samples is stored. It defines
the parameter svfdir. Refer to Format of the Entry Level, for the exact format of this
entry.

2. Sample Directory Template: Defines the directory inside the study directory where all the
data for any sample are stored. It defines the parameter sampdirtmplt. This is always
a subdirectory for the study directory, svfdir. Refer to Format of the Entry Level, for the
exact format of this entry.

3. Data Template: Defines the actual name that is given to the individual fid files. It defines
the parameter svfname. This file is saved inside sampdirtmplt. Refer to Format of the
Entry Level, for the exact format of this entry.

4. Automation Directory Template: Defines location of the automation directory, where the
system stores all the information to do the automation run. It defines the parameter
autodir.

5. Bitmap Image Format: Allows the definition of the format to be used when saving or e-
mailing bitmaps of the spectra recorded. The following are available options:

a. tif. This creates a TIFF format document, typical for accurate representation of bitmap
images. A TIFF document can be read with most common image and word
processing programs.
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b. pdf. This creates a document according to the Adobe PDF™ document format. A
PDF document can be read using Adobe Acrobat Reader. The PDF documents
created from VnmrJ require Adobe Reader version 5 or higher.

c. pcx. This creates a document using the PCX protocol, adequate for representations
of bitmap images. PCX documents can be read with most common image and word-
processing documents.

d. jpg. This creates a JPEG format document accurate for the representation of real-life
photos. JPEG documents can be read with most common image and word
processing programs.

8.1.1 Format of the Entry Level

The format used to enter the directories in the first three fields is the same as was used
previously for “autodir.” A detailed description of it appears under the description of “autodir” in
the Command and Parameter Reference Manual for VnmrJ. A brief description is shown here.

There are three types of text that can be entered in these fields. All the options can be mixed
together generating very powerful saving options.

1.

Fixed text, like “/home/vnmrl/data.” This is interpreted as is without any special
translations. If the text defines an absolute directory path then this path will be used
(example /vnmr/data). If there is no absolute path then the directory will be created as a
subdirectory of the previously defined directory path. So if sample directory is defined as
“mysamples/today” then the subdirectory will be created for the study directory.

Text enclosed in “$” signs. This will substitute the enclosed text with the value of the
VnmrJ parameter with the same name. For example $samplename$ will be substituted
with “mysample” if samplename="mysample’. Any VnmrJ parameter can be used for this.
The most useful ones will be the ones defining sample parameters (studyowner,
samplename, solvent, etc.) and experiment parameters (pslabel which shows what
experiment is run for example). So “$samplename$/$pslabel$” will translate into
“mysample/PROTON?" in the case of a proton spectrum.

Text enclosed in “%” signs. This will substitute the enclosed text with the entry on the
actual enterQ file being used. This can be very cryptic but some useful options are
outlined here. For more detailed description the user is referred to the Command and
Parameter Reference Manual.

a. %DATE%: This will be substituted with the date that the spectrum is acquired.

b. %RX% where X is a number: This will be substituted with a numerical extension in
the form “_00", “_01", “ 02" etc. The number X defines the number of digits that will
be used for the extension, so %R2% will generate “ 01" while %R3% will generate
“_ 001" etc. This ensures that a unique name is generated for every directory created.
A %R2% will be appended automatically to the study, sample and automation
directory templates if one is not explicitly defined. One can suppress this by using
%R0% however this is not recommended as it may accidentally overwrite data.

Examples shows what each of the strings entered translates to. Some useful examples are
displayed below.
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The example shown in Figure 30 will direct all study data to home/chemp/vnmrsys/data/<operator
name>. This is accomplished by the use of the $operator $ argument. Note that the more
proper parameter to use in VnmrJ 3 would be $studyowner$. The data for each sample will
further be saved in a directory named <notebook>_ <page>, where notebook and page are the
notebook and page numbers that were entered in the Start tab of the parameter panel. The
revision number is suppressed here. The actual FIDs will be saved as
<experiment>_<samplename> with a three digit revision after it.

Email disabled [ Enable Email Options

fTempIates r.Al..ih:ll'l'lﬂti"l:ln rQueu'E reap_tib'n's rDat'ﬂ'Mi_rTm" rSnmpIeTag's rl.lse'l‘i’rafs |

Template Preferences: Restore to defiu.lm

Study Directory Template (svfdir); [/home/chemp fynmrsys/data/$operator_§
sample Directory Template (sampdirtmplty; [fnotebook$ _§page$®Ro%
Data Template (svfname); |$pslabelf_§samplename$ _%R3%
Automation Directory Template (autodir); [auto_%DATE%:

Bitmap image format: pdf j Time display format: [L2Haur (&M /FM) ;I

Examples:

Study Directory:  fhome/chemp/vnmrsys/datafmmrl
Sample Directory. 1235
Data; H5QC_Vitamine_D3_001.fid
Automation Directory. auto_ 2010012001

Save J

| Edit,.. || Undao || Close || Abandon |

Figure 30 Setting the Preferences Window

The example shown in Figure 31 illustrates the inclusion of a fixed text in the sample directory
name (Book_<notebook>) and dates.
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Email disabled [[] Enable Email Options

l/TempIates rAutumatiun rQueue reOptiuns rDataMirrur rSampIeTags rU§erPref§ |

Template Preferences: Restore to defiH_

Study Directory Template (svidir): |/home/chemp wnmrsys/data/$operator_§
Sample Directory Template (sampdirtmplt): [Book_$notebook§%R0%
Data Template {(svfname): [Page_$paged _$pslabeld _$loth_%R3%
Automation Directory Template (autodir): [auto_%DATES

Bitmap image format: pdf j Time display format: 12 Hour (AM /PM) ;I
Examples:
Study Directory:  fhome/chemp/vnmrsys/data/vnmrl
Sample Directory. Book_123
Data; Page_5_HSQC_7_001fid
Automation Directory. auto_20100120_01

Save J

| Edit... || Undao || Close || Abandon |

Figure 31 Example—Inclusion of text in the sample directory

The example in Figure 32 shows the date is part of the directory name.

Preferences

Email disabled [] Enable Email Options

[ Templates | Automation | Queue | eOptions | DataMirror | SampleTags | UserPrefs |

Template Preferences: | _ L -

Study Directory Template (svfdir): |fhome/chemp/ynmrsys/data/$operator_§
Sample Directory Template (sampdirtmplt): [$samplename$ %DAT EX%R0%
Data Template (svfname): $samp|ename$|_$pslabe\$_$|ots_%R3%
Automnation Directory Template (autadir): [auto_%DATE%

Bitmap image format; pdf ﬂ Time display format. 12Hour (AN

Examples:
Stuchy Directory:  fhome/chemp/ynmrsys,/data/ynmrl
sample Directory, Vitamine_D3_20100120
Data: Page_5_HSQC_7_001 fid
Automation Directory, auto_20100120_01

Save ‘J

| Edit. || Unda H Close || Abandan |

Figure 32 Example—Inclusion of the date in the directory name

Data from one operator can be sorted to different subdirectories according to the date the data
was recorded.
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Preferences

Email disabled [ | Enable Email Options

[Templates | Automation | Queue | eOptions | DataMirror | SampleTags | UserPrefs |

Template Preferences:

Study Directory Template (svdir): [/home/chemp /fvnmrsys/data/$operator_§ /%DATE%

Sample Directory Template (sampdirtmplt): |$samplename$%R0%
Data Template (svfname): ($samplename$ _$psliabeld_$loth_%R3%

Automation Directory Template (autodir); jauto_%DATE%

Bitmap image format, pdf j Time display format: mHnur(MM{Pw ;I

Examples:

Study Directory:  /home/chemp /smmrsys/data/ynmrl/20100120

Sample Directory: Vitamine_D3
Data: Vitamine_ D3 _HSQC_7_001.fid

Automation Directory: auto_20100120_01

Save _J

| Edit... || Unda || Close || Abandaon |

Figure 33 Example—Inclusion of the date in the study directory template

NOTE: Any changes done on this window should be saved before exiting the window; otherwise,
changes are lost. The changes usually require the creation of a new automation run to become

active.

Automation Tab

Preferences

Email disabled [ | Enable Email Options

Automation | Queue [ eOptions | DataMirror | SampleTags | UserP

Automation Preferences: traymax= 12 Create new autodir?
Always use current ;l

Sample Change Time |60 sec
Frocess/plot Time |30 sec

Shim each sample from Last shims ;I
Skip sample if protune fails []yes

Max priority samples |2 (per operatar)

When DayQ exceads time limit; redirect Exp to NightQ [v] Studies in progress
Locations selection: Let user select: ;I Errored Studies
Auto-resubmit error@; [ yes | Active Study

Default Automation Temp. (C): |30 [] Ambient Queued Studies

Whenever the automation Queue is empty... [ | Use standby sample (loc=12)

Save _J

| Edit... || Unda || Close || Abandaon |

The Automation tab defines the defaults that will be used for automation experiments. Defaults
are described in the following table.
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Field

Description

Traymax

This parameter indicates what type of autosampler is actually
used. If this is not set up properly then it needs to be changed in
the System Preferences window. Only vnmrl can make this
change.

Sample change time

This is the approximate time required for the sample change
using the autosampler, the finding of the z0 value for the
automatic locking, the automatic tuning (ProTune) and the
automatic shimming. The default value is 120 seconds which
should be sufficient for most cases. It is generally advised to
round the time rounded up, so if the system needs 100 seconds
to enter instead 120. This ensures that the time calculations will
not fall off because of too short estimates.

Process/plot time

This is the time required to process, plot and save the spectrum.
The default value of 10 seconds should be sufficient. Use a
longer value only if you are using a slower computer.

Shim each sample from

This defines the shims started by the system when the shim
tries to shim a new sample. There are two options:

Last shims: Last shims use the shims from the previous sample
run

Default shims: Default shims load the shim file that is in the
probe file. In actual operation with properly prepared sample the
outcome should be equivalent. If however that range of samples
and tubes used varies widely then the use of Default shims give
more consistent results.

Skip sample if Protune
fails

This check-box appears only if ProTune is installed. If checked
then the system skips the sample in the unlikely event that the
automatic tuning fails.

When the check box is not selected, the data acquisition
proceeds.

Maximum priority
samples

This defines the maximum priority samples an operator can
submit in each automation run. The right to have priority
samples is granted from the VnmrJ administrative interface.

When DayQ exceeds
time limit

Select redirect Exp to NightQ if the DayQ has exceeded it's
time.

Locations selection

This drop-down menu defines whether users will be allowed to
choose the sample location manually (Let User Select option) or
not (Next Available option). The Next Available option will ignore
the user input and submit the experiment queue for the next
available sample position in the autosampler.

Auto-resubmit errorQ

Select yes to automatically have the software resubmit samples
back into the queue if it has errorred.

Edit/resubmit option

This option either allows or not the right to edit and resubmit a
study queue that has already been submitted.

Default Automation

Defines the temperature default for all samples run in
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Field

Description

Temp. (C)

automation. If at the time New Automation run is started,
temperature control is enabled in the account, a new
temperature can be specified at customization time. The
software checks if the chosen temperature is safe given the
choice of solvent for that sample. In addition, if variable
temperature is allowed in sample changer automation, it is
important to set the value for the tin (temperature interlock)
parameter contained in ~/vnmrsys/modules/cpQdefaults be set
to “w” so that the sample changer will not insert any sample until
the probe has reached the requested temperature.

Whenever the automation
gueue is empty

If you select this checkbox, a standby sample is inserted into
the magnet whenever the automation run finishes and there are
no more samples in the queue. This removes the last sample
run from the magnet thus allowing its owner to retrieve it from
the autosampler tray. The standby sample needs to be placed in
the position indicated in the field, position 96 in the case of the
figure above. That particular sample location is not available for
use.

Set Time Schedule

Opens a tool for defining how time is managed in automation

StudyQueue View
preferences

Displays options for what is displayed in the Study Queue when
the Spectrometer view is selected.

" Automation Schedile

Time Schedule for
(] Higna
baging at marges at

Monday: 8:00a8 =] &00FH

Tuesday: | ]
Wednesday: | _
Thursday: | =
Friday: - &
Saturday: | =
Sunday: = o

AutoRuns AutoFiles
. ST Y ST
HaxTime HaxTime MaxTime
MaxTime per Sample During Total lime Total time
pér Sample pr Sample pér Sampla
variabls Before 5.00
Alday S og Mimned w] | dohes  wf 30mn  w| a4nes  e] unimted v
7] &l day Unlimned =] | d0hs =] 30mn =] 14ns = Unimied >
«| All day Uniimied =] | 1oms x| 30mn x| 14 ] Unimmed
v All day Unlimied =] | 10+ =] zom =] 1aws =] unimited =]
B EIARAWY o o gy | Unimited =] |1onms =] zom =] aams = unamies a =
2 ] Al dary untimted  »] 1o ) zomn  w| 1ans vf unimgea v f
2] ¥ & day Unlimied =] | 10hs <) 3omin =] 1d4ns < Unimied |
fed T
ave this Schedule
I

The Automation Schedule tool allows the account administrator to define how time is allocated
during the day or night for AutoRuns (typically on demand sample automation) and AutoFiles

(sample queues built for submission at a time chosen by the account administrator). Selecting the

All Day check simply turns- off time management and is a better choice for a research
environment as opposed to an open system being accessed by a large number of chemists.

Using the Automation Schedule tool, the user can define different queue times for different times
of the day as well as after hours’ queues. At sample submission time with the NightQ enabled, a

chemist can submit certain experiments to the day and others to the night.
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8.3

There are definitions for each day of the week. The first two columns define when does the day
and the night start They are only active if the All day option is not selected. The third column, Max
Time per Sample, defines how much experiment time will be allocated per sample during the day.
The column with the same name further to the right defines the maximum time per sample during
day and night runs.

The definitions for the AutoFiles are similar, with the fields defining how much should the total
time for short and long queues be and how long should the maximum time per sample allowed for
short and long queues be

Please note that any changes done on these two windows need to be saved (red button Save)
before exiting the window, otherwise they will be lost. The changes will usually require the
creation of a new automation run in order to become active.

Queue Tab

Preferences

Email enabled Enable Email Options

rTempIates rAutomation r Queue r eOptions r DataMirror r SampleTags r UserPrefs

Queue Preferences: [User can override Autolock, AutoShim,ProTune, TempPad options]

Before First (Day and Might) Experiment; [v] AutoLock  [w] AutoShim
[v] Allow submssion to Automation Queua

Before First (Day and Might) Experiment: ProTune
BEefore First acq. equilibrate sample Temp for: ’T sec (TempFPad)
[] After findz0 routine read lockphase fram probe file (automation only)
Before sample insert, allow..Wsec for Temp to change; Else.. ignore 'l

[v] Allow submission to Non-automation Queue

By default, run cueue in: foreground (curexp) LI

Eefore First Experiment: FroTune

Save |

| Edit... || Undo || Close || Abandon |

Figure 34 Queue tab - Preferences window

The Queue tab offers options for the actual automation queue. All settings at this page are default
settings. Each sample submission will start with these default settings. They can be overwritten
during the sample submission.

The first field defines whether the system will be automatically locked and shimmed before the
first experiment of a sample queue. The normal behavior is for each sample to be automatically
locked and shimmed and this is set here. If, for some reasons, one does not want the samples in
the queue to be automatically shimmed and locked then these boxes should be unchecked.
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Allow submission to
Automation Queue

This setting activates the automation queue. If this is not
desired then this should be unchecked.

If the system is equipped with a ProTune module then the
option for automatic tuning before the first experiment
appears here If automatic tuning before the first
experiment is not desired then this box should be
unchecked.

Before first acq. Equilibrate
sample temp for

This sets the amount of time that the system will wait for
the temperature to equilibrate after it inserts the sample in
the magnet but before recording any spectra. The default
value is 2 seconds and it should be sufficient for
experiments conducted at or near ambient temperatures.
Increasing this value has got the advantage of having the
temperature better equilibrated in the sample but the
disadvantage of increasing the time required for each
sample.

Before sample After findzO routine read lockphase from
probe file (automation only). This is a setting for optimizing
the lock system before spectra are recorded. If selected
then the lock phase is set to the value in the probe file
overwriting any value that has been set manually. The
normal value for this box is to be unchecked. It should
only be checked if there is a suspicion that the lock phase
is not set properly. In this case the probe file should be
updated with the correct value for the lock phase.

Insert allow XXX seconds for
Temp to change, Else..

This value selects the amount of time the system waits
after retrieving a completed sample but before inserting
the next sample for the temperature to equilibrate. This is
a useful feature when operators are allowed to run
samples in automation at different temperature. It is
placed there in order to avoid the case where a sample
was run at a temperature higher than the boiling point or
lower than the freezing point of the next sample solvent.
The time defined here is the maximum time that the
system will wait for the temperature to equilibrate. If the
temperature equilibrates faster, the run continues. The
actions in the pull-down menu define what will happen if
such a condition is met and there is no waiting time
defined. The possible actions are:

“Ignore”, which causes the system to ignore the condition
and proceed with the sample submission, “Abort”, which
causes the system to abort the automation run and “Alert”
which gives a warning to the operator.
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Allow submission to Non- By default run queue in:

automation Queue This option defines how the automation will be run. The

two options are “In the background (autodir)” and “In the
foreground (curexp)”. The background option runs the
AutoFiles automation in the same way as the standard
automation run by holding all the information in the autodir
directory. The foreground option will run all the automation
in the current VnmrJ experiment.

If the system is equipped with a ProTune module, the
option for automatic tuning before the first experiment
appears here If automatic tuning before the first
experiment is not desired then this box should be
unchecked.

NOTE: Any changes done on this window need to be saved (red button Save) before exiting the

window, otherwise they will be lost. The changes will usually require the creation of a new
automation run in order to become active.

8.4 eOptions Tab

.ﬂ Preferences

Email disabled [ | Enable Email Options

rTempl'iites rAutuma.tibn rQUEue reOptiuns rDataMirru'r r.SnmpleTa.gi rUSErPre-fs

e0ptions Preferences: [User can override Flot2plotter option]
After BEvery Experiment: [_| Plot2 plotter
[ Isave a plot
] Email a plat
[ 1Emall the fid
Bitmap image format; pdf j
Save ‘
| Edit.. || Undo || close || Abandon |

The eOptions tab defines actions that will be taken to produce an electronic output of the
recorded spectra. The default options set on this tab will be used with every new study queue.
Each operator has the option to override these in the Start parameter panel during the
submission of the queue.
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The available options define what happens after every experiment. The available options are:

plot2ploter This produces a hardcopy output to a defined plotter.
Save a plot This saves the plot in the format defined below
Email a plot This option is enabled only if the “Enable Email Options is checked

at the top of the window. If it is then the system will send a plot of
the recorded spectrum as an e-mail attachment to the e-mail
address of the operator who submitted the sample.

Email the FID This option is also enabled if the “Enable Email Options” is checked
at the top of the window. If it is then the system will send the entire
fid with the recorded spectrum as an e-mail attachment to the e-
mail address of the operator who submitted the sample. This option
should be used with care as NMR spectra, especially
multidimensional ones, can grow to very large sizes which may not
be accommodated by the available capacity and bandwidth of the

network.
Bitmap image This pull-down menu defines the format of the plot that will be
format saved or e-mailed. Options are:

e tif. This creates a TIFF format document, typical for
accurate representation of bitmap images. A TIFF
document can be read with most common image
and word processing programs.

e pdf. This creates a document according to the
Adobe PDF™ document format. A PDF document
can be read using Adobe Acrobat Reader. The
PDF documents created from VnmrJ require
Adobe Reader version 5 or higher.

e pcx. This creates a document using the PCX
protocol, adequate for representations of bitmap
images. PCX documents can be read with most
common image and word-processing documents.

e jpg. This creates a JPEG format document
accurate for the representation of real-life photos.
JPEG documents can be read with most common
image and word processing programs

NOTE: Any changes done on this window need to be saved (red button Save) before exiting the
window, otherwise they will be lost. The changes will usually require the creation of a new
automation run in order to become active.
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8.5 Data Mirror Tab

Preferences

Email enabled [¥] Enable Email Options

DataMirror Preferences: [ on/fOFF

Template for FIDs:
Template for Flots:
Template for Spectra;

Bitmap image format: j

Dynamically maintain a 2nd copy of the Sample Directory:

Template for Fath to 2nd copy: ]
Examples: FIDs:

Flots:

Spectra;

Fath to 2nd copy;

Save ‘

| Edlit... || Undo || Close || Abandon |

VnmrJ 3 provides the option to automatically store another copy of the data recorded in
automation on a local or remote disk. Use the Data Mirror tab to setup this feature is defined.

If the option is turned on (ON/OFF check box at the top of the window) the feature is activated
and each dataset is saved twice: first at the locations defined in the Templates tab, second at the
locations defined on this tab. The syntax for the templates is identical to the ones in the
Templates Tab.

There are three types of files that are mirrored: FIDs, Plots and Spectra. The entire sample
directory can be mirrored and defined in the last field on this tab.

Data mirroring can be useful for backup. When used with externally mounted or network drives,
users can access data at other systems. This can have several benefits: reducing the load on the
spectrometer computer host, reducing the need for extensive network transfers of data.

A complementary tool to this is the UNIX function of rsync. The way to setup rsync is described in
most UNIX manuals.

NOTE: Any changes done on this window need to be saved (red button Save) before exiting the
window, otherwise they will be lost. The changes will usually require the creation of a new
automation run in order to become active.
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8.6 SampleTags Tab

The SampleTags tab allows the system administrator to define which parameters required for

each sample will be recorded.

Email disabled

[ | Enable Email Options

Sample Tags:

[ These parameters and
their values will be
preseryed during a
queued acquisition. |

| Templates | Automation | Queue | eOptions | DataMirror | SampleTags | UserPrefs |

Basic [Fequired] UserSampTags "regpanals"
adir2tmph Fri

aclirtmph

emailaddr

archivedir =

nameprefix

lot |

page Farametars
notebook in the list above
amessage

sample may not have
samplenamse |w= empty values |

Save Sample '_[i_g.gs_ ‘

Save

‘ Edit... H Lndo H Close H Arandaon |

The window displays three lists of parameters:

Basic (required)

These are parameters that are required for each sample, like the
samplename, the data directory where data are saved etc.

UserSamp Tags Any extra parameters that the system administrator may want the users
to be entering. Normally this would require a respective entry into the
userficpar macro. Such parameters may be, for example, the
department which the operator belongs etc.

“reqparvals” This column contains the parameters that will be absolutely required to

be entered otherwise the automation run will not be able to proceed.
Note that any parameter appearing as data saving parameter in the
Templates tab will automatically be required and one does not need to
enter it again here.

NOTE: Any changes done on this window need to be saved (red button Save) before exiting the

window, otherwise they will be lost. The changes will usually require the creation of a new
automation run in order to become active.
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8.7 UserPrefs Tab

The UserPrefs tab allows the account administrator to setuE oEtions for oEerators.

Email enabled Enable Email Options

| Templates Automation  Queue eOptions DataMirror  SampleTags UserPrefs
R

[ ] UserPrefsRemembrance disabled

After userlogin, do..

Do nothing v|

After Sample submission, do..

Do nothing ¥ |

Save _J

| Ed it || Unda H Close || Abandan ‘

The first task the account administrator must perform using the UserPrefs tab is to decide the
action to be taken after sample submission.

Preferences

Email enabled Enable Email Options

[ ] UserPrefsRemembrance disabled

After userlogin, do...

Do nothing j

After Sample submission, do.

Do nothing = k
Do nothing

Clear Queus

Quit Submit mode
Operator logout

Save J

| Edit... || Unda || Close || Abandan |
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The choices:

Do nothing Enables the user to leave the list of experiments in the
StudyQueue in place for submission in full or in part to another
location.

Clear Queue Clears the experiment list while leaving the interface in

submission mode for easy creation of a new queue for other
sample locations.

Quit Submit mode | Automatically clicks the Done button and exit sample
submission mode and leaves the operator in Data Review
mode.

Operator logout Quits submit mode and logs that operator out automatically.

This is an excellent choice for a high-volume NMR service lab
with lots of operators who tend to generally submit one sample
at a time.

The account administrator next defines the interface personality at the time of operator login.

Email enabled [¥] Enable Email Options

Templates Automation Queue eOptions DataMirror SampleTags  UserPrefs
] UserPrefsRemembrance disabled

After userlogin, do...
Do nothing n i

After Sample {Do nothing
Show Tray
Ready for submit

Save |

‘ Edit || Urid: H Close H Abandan |
The choices are as follows:
Choice Description
Do nothing Lets the operator choose the way
Show Tray Displays the automation tray
Ready for submit Automat_lcally clicks Nevy Sample” button to enable the
submission mode of the interface

In the UserPrefs tab, the option UserPrefsRemembrance enables the user to set values
for any desired parameters that can be pre-set upon entry of sample submission mode.
The parameters can be unique for each operator, allowing users to easily manage pre-
filling of items such as preferred solvent, notebook, email address, and so on.
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Note that once enabled and the parameter list for remembrance is defined by the account
administrator, individual operators can manage their own preferences for those
parameter via the menu Edit=>Operator Preferences.

Prererences

Email enabled |v| Enable Email Options

| Templates  Automation Queue  eOptions  DataMirror  SampleTags = UserPrefs

S [v| UserPrefsRemembrance enabled

= : i
Include:[¥] Plotter [¥] Printer After userlogin, do..

notebook |
[ Farametars in tha e laadn Do not_hmg_ A
table can have solvent After Sample submission, do..
operator specific HEG= %ﬂ

default values --]

Setup Default values

Save ‘

| Edit.. H Unda || Close H Abandon ‘

In this example, the operator choices for printer, plotter, notebook, email address, solvent, and
page have been defined by the account administrator by entering those checks or parameter
names into the entry box. After the first time, the account administrator must select the Setup
Default values button to assign defaults for the user to start modifying values.

Operﬂi;__ur Preferences Setup

Preferences for vamrl: Save as Defaults | Restore Defaults J

printer printer [b+w] ﬂ plotter plotter [b+w] ﬂ
nutebuuk] emailaddr
solvent DMSO ﬂ page

| Edit... || Undo || Close || Abardon |

The menu for plotter and printer read valid devices known to the NMR spectrometer and each
operator can choose the location where the data hard copy is plotted. The userRemembrance
tools help prevent keying errors of items such as a laboratory notebook and preferred solvents. In
this example the email address is controlled by the operator and not an administrative task for the
account administrator. An operator can choose to direct PDF plot emails to any desired email
address.

NOTE: Any changes done on this window need to be saved (red button Save) before exiting the
window, otherwise they will be lost. The changes will usually require the creation of a new
automation run in order to become active.

100



Chapter 9 Quantification Tools

9.1

VnmrJ 3 provides two new tools to facilitate NMR quantitative measurements: Quanttools located
in an application directory, and the gEstimate tool.

The package of programs in Quanttools provides a mechanism to assay any sample for a specific
chemical substance. This method uses a user-generated template that must first be interactively
created from an NMR spectrum, acquired on a standard sample. This method supports
automated analysis and report generation once user-generated template is in place. The use of
internal standards is required to perform these analyses.

Use the gEstimate tool to provide an estimate of absolute concentration for any sample. This
capability is based on the linearity of the digital receiver and does not require the use of reference
signals or the addition of reference standard compounds to the NMR sample. A simple
calibration must be performed once for each probe before this tool can be used, see Calibrating
probe parameters for quantitation.

Sections in this chapter include:
e 9.1 Quanttools Application Directory
e 9.2 The gEstimate tool
e 9.3 Automated Creation of Quantification Reports

Quanttools Application Directory

To access the tools:
1. Enable the Varian QuantTools application directory.
2. Select Applications... from the Edit menu,
3. Select Enabled from the pull-down menu next to /vnmr/quanttools.
4

Exit and restart VnmrJ to load the new menus and panel items, after the application
directory is enabled.

101



9.2

Application Directory Application Label

[USERDIR [Hame account

[/ biopack [Varian Biopack

[nmir/quanttoals fVarian QuantToals

fnmr Varian system
\ i

[hmmr/autotest fVarian Autotest

Save as global applications directories

® Save as private applications directories

Remaove(d)
Enabled
Remove(d)
Disabled
Remove(d)
Enabled
Remove(d)
Enabled

Remove(d)
Disabled
Remove(d)

A 4[4 )4 |44 )4[4]4]4

Reset to system default applications directorias

Cancel

Figure 35 QuantTools application directory as enable.

The gEstimate tool

9.2.1 Calibrating probe parameters for quantitation

Before the gEstimate tool can be used, a simple calibration step must be performed. This
calibration is specific to each probe and receiver combination.

1.

Carefully prepare a sample of known concentration. Any sample in the 40 to 100 mM
range should be suitable, assuming that a.) it contains a resonance, or group of
resonances, that are well separated from all other signals, b.) that resonance is
reasonably sharp, and c.) the number of protons represented by that resonance is
known. The *'P signal to noise standard sample provided with the system can be used
with reasonable results.

Insert the calibration sample and ensure that the probe is properly tuned and shimmed.
Set the number of transients to 1 (i.e., nt=1) and turn off the steady state transients (i.e.,
ss=0). Set the receiver gain manually to a value that provides good signal-to-noise
without giving a receiver overflow error (letting the system set the gain value
automatically could introduce relaxation errors). Acquire a spectrum.

After processing the spectrum, navigate to the Integration panel under the Process tab.
Establish an integral region around the resonance to be used for calibration using the Set
Integral Regions tools. Make sure to include some baseline on each side of the peak in
the integral region. Place the cursor within the selected integral region.

Multiply the concentration of the calibration standard by the number of protons
represented under the resonance chosen in step 3, then enter that result into the Integral
Area field. For example, if the standard sample was created at a concentration of 94.36
mM and the resonance used for calibration was a methyl group (i.e., 3 protons), the
number entered into the Integral Area field would be 283.11 (i.e., 94.36 x 3 = 283.11; see
Figure 36). Select the Set Integral Region button.
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40 39 ER:] 37 36 35 34 33 3z 31 30 29 ppm
L _
2 x
Start| Acquire | Process Transform Aumnrmg“ Display Spectrum Clear Screen |m
Basic Integration Set Integral Area Display List of Integrals |
Default Integral Display Mode Display Normalized Integrals
Weighting d i V. MNormalize Area To: ey o |
A Full @ Partial Off = =
Display ® Single Peak sum region  start(ppm)  end integral
Mare 10 < o i A B 1 3.80798 3.7129 281.213
inteqration cdle feplav o Imegral Area [283 11 2 3.3367 3.22922 283.11
T " - - 3 3.17548 3.05008 283.597
Cursors/Line Lists| Set Integral Regions Set Inteo gl Value
Plot Auto Find Integrals

Show Integrals
Show Integral

Text Output

Estimate Concentration

Figure 36

Setting the integral value for a calibration standard of caffeine dissolved at a
concentration of 94.36 mM, see Figure 36. The integral region for the methyl signal at
approximately 3.28 ppm has been selected and a value of 283.11 has been entered into
the Integral Area field.

If the 3P SIN sample is used to calibrate the system, integrate the all the aromatic
resonances as a group and enter the value of 727.5 into the Integral Area box. The
sample is approximately 0.485 molar and the aromatic resonances represent 15 protons
from 3 phenyl rings. The small amount of residual CHCI3 also in the region does not
significantly effect the calibration.

5. Type gestimate(“setproBefile”) onthe command line and hit Return. This will
create the parameters required for the gEstimate function and store appropriate values
for those parameters in the probe file. The parameters that are created by
gEstimate(‘setproBefile’) are H1Qgain, H1Qins, H1Qinsref, H1Qconc, and H1Qmult.
H1Qmult refers to the tip angle scaling factor where a value of 1 equals a 90 degree tip
angle.

Once these values are on the probefile, sample concentration is accessible by a mouse click.
The results are still dependent on the physics and relaxation properties of the sample. Typically,
reasonable results are obtained from normal survey ‘H spectra. More precise results can be
obtained by using a single scan fid acquired with a 90 degree tip angle and fixed receiver gain.
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9.3

9.2.2 Using gEstimate

Whenever gEstimate is evoked the gain and tip angle for the current sample are noted and
compared with the values used for during calibration. The parameter ins (concentration for the
standard) is loaded into the current experiment and the parameter insref is adjusted from the
value shown on the probe file for the scaling factors defined by receiver gain and tip angle.

To determine the concentration of an NMR sample:

1. Acquire a proton spectrum.

2. Integrate a resonance (or group of resonances) representing a known number of protons.
3. Select the Estimate Concentration button on the Integration panel.
4

Divide the integral area displayed for a give peak by the number of protons represented
under that peak.

This yields the millimolar concentration of the sample is the result from step 4.

For example, the methyl resonance of an isopropyl group represents 6 protons. If integration of
the isopropyl methyl signals from an unknown sample yielded a value of 339.6 after clicking
Estimate Concentration, then the concentration of the sample is 56.6 mM (339.6 + 6 = 56.6).

Automated Creation of Quantification Reports

A precise answer with respect to the exact purity of a substance is often required. In this situation
the best solution is to add a precise amount of a reference compound and compare the integral
results for the compound to that of the internal reference standard. The purpose of the reporting
macro is to allow a completely automated output of results with the answer in the output rather
than generating raw data for manual analysis after the fact’. In order to generate a reporting
macro prepare a standard sample and include a reference standard and acquire a spectrum
suitable to precise quantification. Either a single scan 90° pulse experiment with fixed receiver
gain or a multi-scan data set with the relaxation delay long enough to ensure complete relaxation.
Four internal standards are supported, maleic acid, dimethylsulfone, dimethylfumarate, or
methenamine.

Quantification requires a number of new parameters that are available via a userfixpar macro
inside of the quanttools maclib. To use an existing userfixpar macro to use the automatic

reporting tools in the quanttools applications directory, edit your local userfixpar macro to
include what is found in the applications directory.

Once the new parameters are created, go to Edit > Preferences > SampleTags and add
userSamptags field, volume, sampwt, iswt, and intstd. This step allows software to know to keep
track of the values for all of these new parameters just as it does for samplename, notebook,
page.
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Email disabled [_] Enable Email Options
[ Templates | Automation | Queue | eOptions | DataMirror | SampleTags | UserPrefs |
Sample Tags: Basic [Required] UserSampTags "reqparvals”
adir2tmplt || lintstd
[ These parameters and adirtmplt iswt
their values will be emailaddr volume
praserved during a archivedic =| |sampwt
e nameprefix
queued acquisition. ] ot
page ] Farameters
notebook in the list above
ermessage
sample may not have
samplename |« empty values |
Save _Sa_ljr!pl‘e,Tags. ‘
Save J
| Edit.. || Undo |[ close || Abandon |
Figure 37

In the Sample Tags page:

Enter the parameters.
Click Save Sample Tags.
Click Save.

Restart VnmrJ.

After the restart. you can enter the quantification-specific parameters in the Standard

page in the Start folder.
Click SetQuantPars to open an entry box.

6] Enter Quantification Parameters

Samplename Sample wgt  IntStd wgt  Internal Std
Ibupropen_Quan  [23.25 [7.32 maleic acid -|
Drug Solvent

X~ | |Ibupropen Methanol - I

Figure 38 Enter Quantitation Parameters window

After a data set has been acquired with the reference standard of a compound of interest,
navigate to the automatic report creation menu found in the Tools Menu. An interactive entry
form and help menu opens to assist the user through the rest of the process.
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Study Clones,., r
Study Queue Actions... 4
Workspace Information...
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Standard Calibration Experiments +
Update Locatar +

Impeort Files to Locator..,
Save Custom Locator Statement...
Delete Custom Locator Staterment...

Maolecular Structures P
Change Password...

Browser..,

Locator...

Select Optieonal Files..,

Sample in Magnet...

Conwvert pre=‘vnmr] 3.0 data ...

Create Quantification Report macro ...
T

Figure 39 Automatic Report Creation menu

The form that is opened by running the Create Quantification Report macro is shown below

Create Report Macro x = Report Macro Help |1!_
Drug Mol wt Internal Std 1) Open commandline tool with view menu if not open already. =
I ] 4;| 2.) Ensure spectrum is properly phased with good baseline.

3.) Integrate all compound peaks, do NOT include

mg /ml solubility estimate Multiple form Spectrum? iHierna st ansartivnse I ventline =
[
4.) Complete all fields on Create Report Macro form.

‘ - 5.) When Create is clicked be prepared to answer questions |

about how many protons are represented by each integral
eg. CH3 = 3, CH2 = 2 etc.

There is an example fid (caffeine) that can be retrieved
and processed from /vnmr/quanttools/data to be used to
learn how to use this interface.

After your report macro is created you can test it by:
Start Menu => setQuantpars. Select your compound from the
sdrualist inst created  Process=% Autn nlot Preview |

4]

| Edit || Undo || close || Abandon

Start'Acquire‘Procus‘ Setup Hardy .n-:—| Cl

Figure 40 Create Quantification Report Form

The following example is of creating a reporting macro for ibuprofen. First integrate the spectrum,
being careful to NOT include the internal standard or the solvent peaks. The internal standard of
the example was maleic acid near 6.3 ppm and the solvent was deuterated methanol with peaks
near 5.0 ppm and 3.3 ppm.
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Figure 41 Integrating the Spectrum

Evoke the Create Quantification Report macro in the Tools menu and fill out the form.

Create Report Macro

Drug Mol wt Internal Std

|il:|uprufen |194_13 maleic acid v|

mg/ml solubility estimate Multiple form Spectrum?
40 na i

‘ Edit... || Undao || Close H Abandon |

Figure 42 Create Report Macro for Ibuprofen

A guess for the solubility estimate field is sufficient.

Select No in the Multiple form Spectrum field if there is no exchange on the NMR timescale
mixing populations.

Click Create and a cursor moves through the spectrum and you are prompted to enter the
number of protons represented by each integral region.
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vIHow many hydrogens at this integral?

Drug Mol wt

mg/ml solubility estimate
40

Internal Std

ibuprofen 194,18 maleic acid hd

] = Create RepoQMacru =

Multiple form Spectrum?
no <

| Edit... || Undo || Close || Abandon ‘

.
oy
o
s
w
[N}

Figure 43 Filling in the number of protons window

After the questions are answered a macro will be created in the local user’s maclib with a name
based on the answers to the questions. In this example the macro will be called
“quant_ibuprofen_cd3od_maleic” because the drug name was given as ibuprofen, the solvent
was cd3od, and the internal standard was maleic acid.

If the purity of the internal standard is 100%, edit the macro and update the entry for $purity on
line 3 to the correct value.

Creating the report automatically adds the name of the drug to the source for a menu in the
SetQuantPars tool.

Enter Quantification Parameters

Samplename Sample wgt  IntStd wgt  Internal Std
ilbupropen_Quan 23.25 7.32 maleic acid v|
Drug Solvent

| lloupropen Methanol hd
caffeine
“libuprofen
Myteslt -—H Undo || Closa H Abandon |

Figure 44 Enter Quantification Parameters window
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When a purity quantification analysis calling the specific reporting macro is finished the macro will
generate a custom output for that sample. There are two ways to hook into automation. Either
one Experiment Selector button with output directed by the parameters entered at the time of
submission or a single Experiment Selector button for each drug. Both strategies require creating
a experiment button.

To create a quantification-specific experiment button begin by first acquiring a fid for the desired
sample. If the parameter execplot does not exist (type execplot? on the command line) then

create the parameter by entering:
create(“execplot”,’string”)

Next open the Edit Parlib tool from the Tools menu.

Update Locator »

ess Tools Help

Study Clenes.., H Clone Current Study

Study Queue Actions... ¥ Clone Current Experimeant
| Waorkspace Information... Clone Location Queue |
=cpl Standard Calibration Experiments ¥ Command and Protocal Buttons | —
ﬁ Edit Parlib.., (3 i

Show Library...

Impert Files to Locator...
Save Custom Locator Statement...
Delete Custom Locator Statement...

Malecular Structures »
Change Password...

Figure 45 Edit Parlib —Tools menu

execplot="execquantpl
Macro Quant created. Parameters for Quant updated

Edit/Make Parlib

Custom Parlib/Exp: (ExpType: PROTON)

Name |QUEU'“
Group |UserExp

apptype: std1D
modules: presat wet gradient quanttools

Lock parameters... [2xecplo]
By default, start with... |
Customization:

User Customization:

i
(rmacro format - overrices all defaults)
Savejupdat(kJ Remove Status
Eject
Hz [] Gi
B.0 C
| Edit... || Undao || Close || Abandon |

Figure 46 Setting the parameters in the Edit/Make Parlib page
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For a single Quant Experiment button where the reporting macro is called by the values in
parameters, drug, solvent, and intstd assign execplot="execquantpl” from the
command line. Then in the Edit Parlib tool add execplot to the Lock parameters list, enter a
name for the button, and click Save/update.

In the example, to create a button called Q_ibuprofen, enter the name into the name field and
assign execplot="quant_ibuprofen_cd3od__maleic” before opening the Edit Parlib tool.

l execplot="quant_ibuprofen_cdZod_maleic’
a Macro Q_lbuprofen created, Parameters for Q_lbuprofen updated
|
o Edit/Make Parlib x|
B
Custom Parlib/Exp: (ExpType: PROTON)
1l Name [2_lbuprofen
Group |UserExp
apptype: 5td1D
modules: presat wet gradient quanttools ld
Lock parameters.. |2xecplot
By default, start with...
Customization: W‘
User Customization:
L
] ®
{macro format - overricles all defaults) —
L Save /update | Remove |
S Status
S Ejec
I
| Edit... || Undo || Close || Abandon | -0 !

The automation report output for ibuprofen is shown below.
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